The NEW PCLinuxOS Magazine

Volume 31 August 2009

♦ Master the Remaster
♦ Audio File Format Comparison
♦ Behind the Scenes:
  Up Close With Old-Polack
♦ Install PCLinuxOS Without a CD/DVD Drive
♦ Repo Spotlight:
  • Pinoc's addlocale and
  • GetOpenOffice
♦ Ms_meme's Forum Foibles

And Much More Inside!
# Table of Contents

Welcome from the Chief Editor ........................................... 1  
PCLinuxOS LXDE 2009 ..................................................... 1  
Master the Remaster .................................................... 2  
Using Bookmarks In Konqueror ......................................... 4  
Deep From Within the Blogosphere ..................................... 12  
Double Take ..................................................................... 15  
Timeth Wins PCLinuxOS Mascot Contest ................................. 16  
Repo Spotlight: Addlocale and GetOpenOffice .......................... 17  
PCLinuxOS International Community Updates ............................. 22  
Flashback: Creating a Favorite Applications Menu ...................... 27  
Wiki Wicket: CheckGmail ................................................... 35  
10 Commandments for Linux Users ........................................ 41  
Behind the Scenes: Old-Polack ............................................ 43  
Installing PCLinuxOS Without a CD/DVD ................................. 47  

Did You Know? ................................................................... 50  
Through the Lens .............................................................. 52  
Forum Foibles .................................................................. 60  
File Format Comparison: Audio Files .................................... 61  
Testimonials ..................................................................... 67  
Startup Volume Script .......................................................... 69  
Profile of a Linux Artist: Ruel24 ............................................ 70  
ms_meme’s little nook: PCLOS Arisin’ ..................................... 73  
Disclaimer ........................................................................ 74
Welcome from the Chief Editor

Welcome to the August 2009 issue of The NEW PCLinuxOS Magazine. This is an exciting time for PCLinuxOS. Not only do we have the new and revitalized magazine to look forward to every month, but there is a lot of other activity going on. Within the last month, we’ve seen the release of MiniMe KDE 3 2009.1, ZenMini 2009.1, and the first quarterly update in PCLinuxOS 2009.2. And there’s even more just around the corner. The final release of the PCLinuxOS XFCE - Phoenix remaster from Sproggy is looming large on the horizon, complete with the latest XFCE 4.6 desktop. Additionally, Neal is wrapping up work on the LXDE remaster, while maddogf16 is hard at work on the e17 remaster. Updates to programs in the repository, as well as new additions to the repository, are coming out at an amazing rate. One of those new additions to the repository that is just around the corner is KDE 4.3 RC3. Texstar has been working feverishly to put the final touches on it, and many from the community have been assisting by testing the next generation of the KDE desktop. The addition of Pinoc’s addlocale program to allow international users to use PCLinuxOS in their native language, has spurred growth in the PCLinuxOS international community, allowing PCLinuxOS to appear in any one of 73 different languages.

In this issue of the magazine, we have a wide variety of articles. This month’s cover story is from Texstar himself, on how to Master the Remaster. Sproggy shows us how to install PCLinuxOS to a computer, from Windows®, without a CD or DVD. Stricktoo shows us a tip on how to use bookmarks in Konqueror, and how to add a Favorites menu to our desktop.
We have interviews of two artists who have made contributions to PCLinuxOS over the years, in Ruel24 and Weric. BigBearOmaha gives us some background on the Linux kernel. Old-Polack reveals a bit more about himself in the Behind The Scenes interview. Ms_meme graces the magazine with another installment of Forum Foibles and her new song, PCLOS Arisin’. Pinoc introduces his new programs, addlocale and Get OpenOffice in the Repo Spotlight. Texstar has contributed the 10 Commandments For Linux Users, which should be required reading for every PCLinuxOS user, both new and not-so-new. AndrzejL shows us how to set up checkgmail on our computer, in the Wiki Wicket column. Patrick Horneker continues his Through The Lens column, with a look at using and setting up flatbed scanners on PCLinuxOS. There is an update from the international PCLinuxOS community, spotlighting the more recent events in the Slavic, Dutch, German, and Portugese communities. And, I continue my article series from last month, with Audio Format Comparisons. Plus, we have a variety of short articles and a testimonial.

I am pleased to be the new Chief Editor of the PCLinuxOS Magazine, and to be able to give back to the PCLinuxOS community in this capacity. I've been using PCLinuxOS for about 20 months, after distro hopping through the *buntu offerings, openSUSE, Puppy Linux, and gOS. Prior to that, I was a long-time Microsoft Window® user, using every version of Windows® from 3.1 through XP. The release of Vista was a great thing for me, as it drove me away from the Microsoft camp, in search of something better. That's how I found Linux.
PCLinuxOS definitely was the "Distro Hopper Stopper" for me. Professionally, I am a former award-winning newspaper photographer. I currently work at a local hospital in the Kansas City area as a Registered Respiratory Therapist, taking care of all kinds of patients with breathing problems, from newborn premature babies to the elderly. I've worked as a respiratory therapist for the last 21 years, including six years employed by a local college where I taught respiratory therapy. I have the most wonderful and understanding wife in the world, Laura, who is also a Registered Respiratory Therapist. We have two cats (Buddie is a lover, Kitty is psycho), and an old dog with cataracts, named Lucky, that we affectionately refer to as "Hoover" because of the way she inhales food. Lucky has three jobs that she does very well: sleeping, eating, and ... well, you guess the third job (it's related to eating, in a way).

I hope you enjoy the labor of love in putting this magazine together for the community, not only from myself, but the dedicated volunteers from the PCLinuxOS community. It is also with great pleasure that I introduce to you the PCLinuxOS Magazine's new Assistant Editor, Andrew Strick (a.k.a Stricktoo). Andrew will be assisting me with the monthly task of putting out the magazine. While Andrew isn't busy with the magazine tasks, he's preparing to enter law school in Omaha, Nebraska in late August.

Paul Arnote [parnote]
PCLinuxOS Magazine Chief Editor
from Texstar

PCLinuxOS LXDE (PCLXDE) 2009 is now available!

PCLXDE is a MyPCLinuxOS Community project, headed by Neal Brooks.

PCLXDE 2009.1 is a self-booting/installable Live CD that features the LXDE desktop environment, along with a minimal suite of lightweight applications. Designed for use on low end computer systems, it's small, fast and fun.

**NOTE:** PCLXDE is designed for PIII or better, and does not work on K6/2 processors.

But wait there’s more!

**Features Include:**

**Administration Tools:** PCLinuxOS Control Center
**Archiving:** File Roller
**Backups:** Simple Backup
**Bittorrent Client:** Transmission
**CD/DVD Burner:** Xfburn
**Dial-Up Client:** Gnome PPP
**Email and News Client:** Sylpheed
**Entertainment:** XPat2 (card playing suite)
**File Manager:** PCMan
**Graphic Drawing:** MTPaint
**Graphic Viewer:** GPicView
**Instant Messaging:** Emesene
**IRC Client:** XChat
**Localization:** AddLocale

**LXDE Tools:** LXDE Control Center (LXDECC), provided by Lord UnR341
**Music Player:** Alsaplayer
**PDF Viewer:** ePDFView
**Remote Desktop Client:** GRDC
**Text Editor:** Leafpad
**Twitter Client:** Twtux
**Web Browser:** Opera
**Word Processor:** Abiword
**Video Player:** Xine

And much more, all on a slim 300 MB Live CD for fast downloading and installation. Not only that but an additional 11,000 programs are available after hard drive installation through the Synaptic Software Manager!

View the announcement, along with more screenshots and download links.
Master the Remaster

by Texstar


Requirements:

* PCLinuxOS LiveCD
* Empty hard drive partition. This can be done in VirtualBox as well
* A large swap file (2 gig recommended)

Steps:

1. Boot the LiveCD
2. Log in as root
3. Edit /usr/share/drklive-install/drklive-install
   and comment (#) out the following lines:

   # enable back some disabled services
   require services;
   services::start_service_on_boot($) foreach
   qw(dkms anacron atd crond syslog);
   sync_logs();

   # Automatically delete the guest account on
   first boot
   system("chroot $::prefix touch /etc/delete-
   guest-account");

   # Setup for root password and create new
   user at 1st boot
   system("rm -f $::prefix/etc/sysconfig/finish-
   install");

   system("touch $::prefix/etc/sysconfig/finish-
   install");
   open FINISH, ' »',
   "$::prefix/etc/sysconfig/finish-install";
   print FINISH "FINISH_INSTALL=yes
   \n";
   print FINISH "LICENSE=no
   \n";
   print FINISH "LANGUAGE=no
   \n";
   print FINISH "KEYBOARD=no
   \n";
   print FINISH "TIMEZONE=no
   \n";
   print FINISH "NETWORK=no
   \n";
   print FINISH "AUTHENTICATION=no
   \n";
   print FINISH "USERS=with_root
   \n";
   print FINISH "USER_AUTOMOUNT first=no
   \n";
   print FINISH "GLX=no
   \n";
   close FINISH;

4. Save the file

Installation:

1. Click Install PCLinuxOS button on the desktop.
   When the video driver removal screen appears press cancel. It will then proceed to the installer leaving
   the fglrx and nvidia drivers installed

2. I usually select custom partitions and make one /
   partition to do my install.

3. This will install an exact duplicate of the livecd
   preserving the guest account and leaving the disabled
   services from being started.

4. Log into your new partition as root. Go back and
restore the commented out sections in draklive-install (don't forget).

5. If you want to save space on your livecd, edit /etc/rpm/macros and add the line `%_excludedocs 1
This will exclude any doc files from installing when doing a Synaptic update or adding new applications.
After installing, removing or updating your applications go back and change the line to `%_excludedocs 0 or remove it.

6. After doing your updates to save even more space you can delete the following:

* /usr/share/man folder (most desktop users will never use these)
* Extra wallpapers in /usr/share/wallpapers.
* Delete pkgcache.bin srcpkgcache.bin located in the /var/cache/apt folder.
* Delete the package lists (main, extra, nonfree, kde, gnome) in /var/lib/apt/lists
* Delete everything in the /usr/share/doc folder except for the HTML folder.

**CUSTOMIZATIONS:**

One area of interest is /etc/skel folder. When a new user is created, everything in /etc/skel is copied to the user's home folder. If you decide to do any changes to your KDE settings be sure to copy the .kde file from root into /etc/skel so the new user created on install will get your customizations.

Gnome users would want to copy .gconf .gconfd

.gnome2 .gnome2_private to /etc/skel folder.

**THERE ARE 3 AREAS THAT CAN AFFECT YOUR ABILITY TO REMASTER:**

1. Make sure the partition that you are remastering is not over 4 gigs of installed applications

2. Make sure no other partitions are mounted when running your remasterme or mklivecd command

3. Remove any entries in fstab that contain the line tmpfs. After removing the entries reboot so that no ramdrive is created.

**EXAMPLE ITEMS IN /ETC/FSTAB TO REMOVE:**

none /tmp/jack tmpfs defaults 0 0
none /tmp tmpfs defaults 0 0
none /dev/shm tmpfs defaults 0 0

Now that you have your install tweaked you can run remasterme in the console and create a new compressed iso.
Using Bookmarks In Konqueror

by Andrew Strick (Stricktoo)

INTRODUCTION

When I recently installed PCLinuxOS 2009.1, I starting getting things set up the way that I like them. As I was working on Konqueror, I was struck by an urge to try something that I've never done before but which might make using Konqueror much more efficient – and the funniest part is that it's so basic and simple that I couldn't figure out how I hadn't ever thought of it before. So what was this magical little tweak?

Using bookmarks and the Bookmark toolbar.

I'm sure that at this point many of you are rolling your eyes at my foolishness. But nonetheless, I'll explain the process.

Before I begin, I should point out that this won't work quite as well if you use also Konqueror for web browsing, since Konqueror lumps all bookmarks together, instead of making a separate directory for Bookmark toolbar items. There is a work-around, but it leaves a little to be desired. And no, switching between the “File Management” and “Web Browsing” view profiles doesn't work.

ADDING BOOKMARKS

On a new installation, the default Konqueror window should look something like this:

As you can see, there are four toolbars at the top of the window: the Menu bar (Location, Edit, etc.) which cannot be moved or edited; the Main toolbar, which contains the action buttons (backwards, forwards, Home, etc.), the Location toolbar, which displays the current directory and allows quick travel to other directories; and the Bookmark toolbar, which displays bookmarks. We want the last one.

The first thing that we need to do is to delete the existing bookmarks. To do this, we will navigate to the Bookmark Editor (in the Menu bar: Bookmarks > Edit Bookmarks).
The next thing that we need to do is to navigate to the directories that we want to bookmark. We'll start with the pre-existing Documents directory.

Once we're there, we'll go back to the Bookmarks menu, only this time we'll select Add Bookmark (alternatively, we could use the shortcut – Ctrl+B – that's listed).

When we do that, a small dialog box will pop up, asking us to name the bookmark.

From here, we can delete the existing bookmarks, either by clicking on the Delete button in the Window or by simply pressing the Delete key on the keyboard. Once the bookmarks are gone, we can close the Bookmark Editor.
Once we click **Add**, the Documents directory will be added to our bookmarks.

Now we repeat with the Movies, Music and Pictures directories. The end result should be something like this:

**AN ALTERNATE METHOD**

Since this is Linux, there is of course another way to add bookmarks. On the left-hand side of the Konqueror window is the **Navigation Panel**, which has several different panes, each of which is accessible via the appropriate button. It just so happens that there is one for bookmarks. In these screenshots, it’s labeled with a yellow star.
To add a directory, we can simply drag and drop it into the Bookmarks pane. We'll add the Desktop directory, since the others are already there from our previous work.

The results:

The downside to this method is that the resulting bookmark is named with the directory's full path. Luckily this can easily be fixed. All we need to do is to right click on the bookmark and go to Properties.

We can then change the Name field in the resulting dialog and the problem is solved.
**One Caveat and the Solution**

If you change your icon theme, the little icons in the **Bookmarks toolbar** will stay the same, which results in something like this:

Notice that the Documents icon in the main Konqueror window has been changed to yellow, but the icon in the **Bookmarks toolbar** is still green. There are two ways to fix this.

{**Bonus:** if you’ve been looking carefully, you may have noticed that the screenshots for the previous section already show the Documents directory and bookmark with the yellow icon. I goofed and created the screenshots for this section before I created the screenshots for that section}

**The Hard Way**

Unfortunately, if we want to change that icon we’re going to have to do it manually. We start by opening the **Bookmark Editor** (**Bookmarks > Edit Bookmarks**) and right clicking on the entry for Documents. We can then select **Change Icon** from the context menu (incidentally, I don’t know what **Update Favicon** does, but despite the name, it didn’t automatically change the icon when I tried it).
We can then pick the correct icon from the list in exactly the same way that we could change any icon in KDE.

**The Easy Way**

Luckily there is an easier way: we'll just turn off the icons in the **Bookmark toolbar**. It's not quite as pretty, but it's much easier (and it also saves space). To do so, we can just right click on the **Bookmark toolbar** and from the context menu select **Text Position > Text Only**.

The results:
THE WORK-AROUND FOR WEB BROWSING

Like I said in the introduction, if we want to implement this while also using Konqueror for web browsing, we're going to have to use a work-around to keep from creating a mess. Unfortunately it's not perfect, but it will work.

We'll again need the Bookmark Editor. Once inside the Editor, we'll click the New Folder button.

Once we've created the folder, we can start dragging our existing links into it.

We can then give a name to the new folder. For the sake of example we'll call it Quick Links.
Of course, this means that we'll have to keep all of our web bookmarks in folders, and all of the folders will appear on the Bookmark toolbar. But hey, it works.

**CONCLUSION**

That's really all there is to it. Bookmarking in Konqueror is fairly simple and straightforward, but it can make your life much easier. There's even an applet that you can add to your panel that will allow you to access an of your bookmarks directly from the desktop!

**More LXDE Goodness**
Deep From Within the Blogosphere

by BigBearOmaha

It was early one morning, the sun began to shine through the windows of the space shuttle as we orbited the dark side of the moon. I was preparing for my space walk to modify the lunar Apache Server which would provide content for the space tourism council. I was bustling around, making last minute checks on equipment, when another space walker entered the prep room. I glanced up only briefly and gave a short wave in greeting as I was preoccupied.

“Well, you Omaha bears aren't nearly as ornery in person as you are in IRC channels,” he said, causing me to stop everything to see who it was who knew me so well apparently. By golly, it was good old Weric, BEL Project member and PCLinuxOS Ripper extraordinaire. As we finished our preparations together to walk in space before the long flight back home, we chatted for a bit. I had my digital recorder on thankfully, and this is how it went...

BB) You sell PC hardware on your online store called “LinPC,” that includes PCLinuxOS being pre-installed on assembled systems. Why did you think to sell Linux based computers?

W) My motivation was simply to help promote PCLinuxOS. I have worked for a reseller for the last 11 years. That put me in a position to get my own wholesaler account with the local distributor.

BB) So you don't intend LinPC to be a "full-time" business, but more like an extension of things you already do?

W) I wish I could quit my job and just watch the money roll in. It seems that it has been a very slow start. Of course, as I mentioned before, I didn't start the site to get rich. I make very little from each system.

BB) You help maintain the PCLinuxOS forums, as well as host some of the MyPCLinuxOS associated sites. Is this a "labor of love," and what motivates you to participate at such a level?

W) Again, I wanted to help with PCLinuxOS. Website development and hosting was an area [in which] I could help.

BB) How did you get into a position as to be able to officially host such sites for PCLinuxOS?

W) After I became a trusted member of the IRC channel, I was asked to be an IRC operator. From there I helped with the main site a bit when it switched to Joomla CMS. Later, the community sites needed a host, and I was able to step up (I wonder if they had thought of a "bribes for Ripper status" email address, that might work).

BB) You host a website called "LinFX," which is a graphics gallery devoted to Linux, mostly PCLinuxOS, related images. How did that get started?
W) This site first began after the PCLinuxOS developers lost some of the graphics associated with PCLinuxOS. I started it as a place to backup the graphics so a loss as before would be less likely. This was the beginning of me trying to give back to PCLinuxOS.

BB) What and when was your introduction to Linux?

W) I was first introduced to Linux in 1999, first Redhat then later Mandrake. I began messing with apache and webmin in 2000 using Clark Connect Router.

BB) Do you think using Tux as a mascot is kind of "sissy" having a cute little penguin, or is it cool because a penguin can also front for a major league hockey team too?

W) I have no clue how the mascot was chosen, but I think its cool.

BB) There have been subtle rumors that you may be slightly partial to the KDE DE. Why is that and are there any other DE's or window managers you like also?

W) Yes I am biased, maybe because I have used it for so long. I find it offers more control than any other DE. I also like Xfce, LXDE, Enlightenment, and even IceWm.

BB) On a scale of 1 to 10, 1 being "dead in the water" and 10 being "the center of all greatness" where does 'home desktop" Linux fit in on that scale? How about "business desktop" Linux?

W) Well, in my opinion, Linux could end up owning both areas. Currently I would say as a desktop its a 3, as a workstation maybe a 4. (He passed the 'raving fan boy test with that answer. Only a raving fan boy would have marked both as a 10.)

BB) How could Linux end up 'owning' these areas?

W) Again just my opinion, but as Linux becomes more popular, more people will move. Along with that, Linux is becoming a better operating system, and the development is moving faster as more people begin to contribute. Eventually, development will be at such a pace that no single company could compete, even MS. People contribute to the development of Linux because they have a love or a need, not because they are paid to do so.

BB) Where do you fall in the spectrum of FOSS software advocacy? Way over on the Richard Stallman "All proprietary software is evil" side, way over on the Linus Torvalds "If it works, use it" side, or somewhere in between? Why? (My bet is Stallman thinks of himself as Obi Wan Kenobi and sees Bill Gates as the villainous Emperor?)

W) Somewhere in between, but very near Linus. I learned computers using MS and proprietary software. That said, I never liked the outrageous cost of it. It doesn't make sense to me that software can cost 3 times the amount of the hardware, even more at times.
BB) If Smokey the Bear took on Yogi the Bear in a "cave match," which would win?

W) Smokey of course. (Actually, Booboo will whoop on both of em.)

BB) Will the 2.6.30 kernel make a major impact in the Linux using world, or not so much?

W) I have no knowledge of major changes in 2.6.30, so I would have to say no more impact than any other recent kernel. (Don't worry about it, 2.6.31 will be "da bomb" so go the rumors.)

At that, the door alarms went off, telling us it was time to get moving. Space walks don't last forever you know. It's good to know that no matter where you are in the universe, you can always find another Linux geek to keep you company. Even in the coldest reaches of outer space.

KDE Korner: Adding an Icon to the Panel to Load/Eject a DVD/CD

Running highlights by Macedonio Fernandez (musonio)

Place the mouse on the kicker panel, right click and select Add Application to Panel > Add Non-KDE Application. In the dialog that pops up, paste the following in the Executable box:

`umount /dev/sr0; eject -T /dev/sr0`

**NOTE:** you must replace “sr0” with the name of the device you want to load/eject.

Be sure that “Run in terminal” is **NOT** checked.

Name it however you like and assign it an icon of your choice.
**Mark's Quick Gimp Tip**

Get more real estate to edit that image in Gimp! First, open Gimp. On the main tool bar window (and all windows) in the upper left hand corner is the little Gimp icon. Clicking on this reveals a new menu with options. Using this menu, we are going to set the Gimp's tool bars so they are always on top of other windows and will automatically shade up and down (and out of the way) so you have more access to the image you're editing.

Click on the menu and select "Advanced." Select "Keep Above Others." Now this tool bar window will always remain on top of other windows. Next, click the Gimp icon once more and select "Shade." Checking this selection will now automatically shade the window when the mouse is moved away. Moving the mouse over the title bar of the window immediately shades it down so you can access all the tools.

If shading is not working, then click the icon once more and select "configure Windows behavior." In this new window select "Advanced" and make sure "Enable hover" is marked. Now, when you work with Gimp you can open your work area to fill the entire screen and the toolbars will always remain on top. The tool bars will open and close when you pass your mouse over them. Note: if you already have "double click" to shade windows enabled, then you can automatically engage the mouse hover by first double clicking the Window's titlebar to shade it up.

-Mark Szorady is a nationally syndicated cartoonist. His work is distributed by georgetoon.com. Email Mark at georgetoon@gmail.com.
Timeth Wins PCLinuxOS Mascot Contest

Timeth won the recent PCLinuxOS Mascot competition on MyPCLinuxOS, with his submission entitled "Dobie the Bull." Timeth competed against nearly 30 other entrants, to take the top prize of a 320 GB hard drive from LinPC. Timeth donated his prize to the PCLinuxOS development team. Users visiting MyPCLinuxOS.com voted on their favorite mascot. The top three vote recipients were then voted on by the PCLinuxOS developers to decide the final winner.

The other two top vote recipients were blndsyd, with his entry depicting a penguin with a necklace, and nealiosnoise, with his robot entry.

Congratulations, Timeth! And congratulations to all the other participants in the competition.
Addlocale and GetOpenOffice
by pinoc

One of the more recent additions to PCLinuxOS is a script called addlocale (AL). This addition provides a user-friendly interface to add one of 72 non-English locales in PCLinuxOS allowing international users to quickly set up PCLinuxOS in their native language. Work on AL also gave birth to the script GetOpenOffice (GOO), a quick and easy way to upgrade to or install the most recent version of OpenOffice in PCLinuxOS. Now that we know what AL and GOO are about, let's go back in time and see how all this came to life.

ADDLOCALE, A LONG STORY...

KDE is the best desktop environment ever, full stop. Huh? Now what has that got to do with AL? Well, a lot. As a long-term Linux evangelist and diehard KDE-fan I finally found the by far best KDE-implementation in PCLinuxOS. That was about 2 years ago but is still true today.

I promoted PCLinuxOS wherever I could, to my parents in Germany and friends and colleagues here in Italy. They all loved the look and feel and the ease of use of PCLinuxOS, but at the end of the day, they did not use it because it was not in their native language. PCLinuxOS was English only, and other distros were multi-lingual.

This was an obvious problem for the promotion of PCLinuxOS into the non-English speaking world. The only way to help my friends adopting the best Linux distro was to figure out how to get PCLinuxOS in Italian. So, off we go, browsing the PCLinuxOS and other forums, digging into all kind of KDE components and documents, the joy of learning by doing, and finally it worked!

Besides adding the new locale settings to the system, you also had to reinstall existing applications to make them appear in the new locale. The necessary steps were summarized in the July 2008 edition of his magazine and can be considered as AL version 0, the "sledgehammer solution" because the entire system is reinstalled, later called REINSTALL-mode.

In the following months, I converted several English installs into Italian using this methodology. Then I thought to automatize these tedious steps and wrapping them up in a user-friendly script. This would allow anybody to easily apply these steps without the need of having to know the details under the hood. Since a new locale is only added to the existing English locale, I called the script addlocale.

After reading and learning a lot about the internal settings and functioning of my beloved desktop environment, AL finally worked for Italian. The next obvious but challenging step was to generalize this script for other locales, first 6, then 20, and finally all 73 KDE3-i18n languages were included. The initial idea was to have AL working for the applications on the 2009.1 CD.
To have an acceptable performance and avoid the rather time-consuming complete system reinstall, I focused only on what I believed to be "essential applications." Most KDE applications worked, but I missed a lot of GTK applications. The number of detected translatable applications constantly increased and now also targeted applications which were not on the 2009.1 CD. Yet, I never knew how to get a complete list of translatable applications for a given locale. This continued up to version 1.6.

Then I finally understood that the translation-relevant information is contained in so-called mo-files, which gets added to the system for the chosen locale during the re-installation of a given application. I wrote a separate script which browses the entire PCLinuxOS repo (14GB), searches each rpm for mo-files, and, for each locale, builds a complete list of all translatable applications. These lists were integrated into version 1.7, the system RPMs are compared against this list, and only those applications having a mo-file for the new locale will be reinstalled.

AL 1.7 was completely redesigned into a new modular structure: Part 1 is generic and adds locale specific extra packages like fonts to the system. Part 2 deals with the mo-files which are extracted during reinstalling the locale-specific rpms. The new modular structure in AL 1.7 had the additional advantage to group the window manager specific settings into a separate section and, as a result, AL could now be extended to non-KDE window managers such as Gnome, LXDE, etc.

**FAST-mode and Foreign Translations...**

The next major change came with AL 2.0. Only now I realized that the time-consuming and tedious rpm-reinstall in Part 2 could be replaced by simply extracting a pre-build archive of locale-specific mo-files into the respective locale directory. I modified my separate script to first, build a new database of extracted locale-specific mo-files using the information of the entire repo, and second, pack the mo-files into locale-specific archives. AL 2.0 just downloaded and extracted such a mo-file archive into the system.

This new approach, called FAST-mode, replaced the time-consuming download and reinstall of typically 500 MB of RPMs by a small download of ~ 10 MB, shortening the entire reinstall process in Part 2 from a about 20 minutes to 2 seconds, not to mention the gain in the download time.
Another big advantage of using a pre-compiled mo-database was the ability to utilize translations of other Linux distributions. For example: the PCLinuxOS RPM for the application Synaptic does not have a Swedish mo-file, so reinstalling Synaptic in a Swedish locale can not provide a Swedish translation for Synaptic; instead Synaptic will remain in English. Yet, in a Swedish Ubuntu installation, Synaptic is in Swedish.

Investigating the Ubuntu deb-package for Synaptic, I found the Swedish mo-file, copied it from a Swedish Ubuntu install to my Swedish PCLinuxOS test machine in /usr/share/locale/sv/LC_MESSAGES/, relaunched Synaptic, and, surprise, Synaptic was in Swedish!

The obvious next step was to yet again modify my separate script with the added feature to scan all Ubuntu deb-files for mo-files not present in PCLinuxOS. These mo-files, or any other mo-files found by our users in any other Linux distribution, are then added to the PCLinuxOS only mo-file database. The trick with using foreign mo-files is only useful for applications for which PCLinuxOS does not have any translation available.

PCLinuxOS mo-files have the highest priority, and any foreign mo-file will no longer be used as soon as a PCLinuxOS mo-file becomes available. Based on the concept "we do not need to translate what others have done already," the PCLinuxOS mo-file database is enriched by the Ubuntu mo-files and updated on a monthly basis. The locale-specific mo-file archives are packaged and uploaded to a server, from where they can be accessed for easy access to our users by AL. In this way, I can provide new, regularly updated translation information from my separate script without having to change anything in AL itself.

The new FAST-mode worked very well and completely replaced the previous REINSTALL-mode in the next version of AL, which had the exciting new feature to be also applicable on a LiveCD. This way, the user can
start the English-only LiveCD, add the native locale to the system during the live session, and then install the already localized system to the hard disk. The next AL version 2.2 supported installing or upgrading to the latest localized version of OpenOffice 3.1.

**GetOpenOffice**

At this point, I heard about the quarterly update project and got in contact with Neal Brooks. I loved the idea of the project, and I am very grateful to Neal for providing great feedback when testing AL.

Due to space constraints, OpenOffice had to be removed from the 2009.2 CD. However, AL now had the option to include a localized version of OpenOffice. Based on Neal's suggestion, I re-used some sections of AL to fork a new application called GetOpenOffice (GOO). The first version GOO 0.3 provided a simple way to upgrade to or install the most recent localized OpenOffice corresponding to the current system locale. GOO addresses all potential pitfalls when upgrading OpenOffice, and frees the PCLinuxOS users from having to configure the special PCLinuxOS OpenOffice repository.

Based on a coincidental observation by Neal ("this is weird...") we found out that the available disk space for changes during a live session equals 49% of the available RAM. Armed with this new knowledge, I started recoding AL and GOO to test for sufficient disk-space before installing the user-selected options, which is of particular interest when running in a live session.

The next GOO version had the option to select any of the 104 OpenOffice locales from a list, independent of the current system locale. Further information on the availability and installation of localized OpenOffice dictionaries and a test for providing optional Java support in OpenOffice were added. The next versions of AL and GOO performed a rigorous test on the repository configuration in Synaptic which was found to...
be the source of issues reported by some users.

In addition, a test for, and optional installation of, common fonts was added in order to improve the cross-platform compatibility of OpenOffice documents. OpenOffice is now also set to use its own dialogs for opening and saving files. This setting makes OpenOffice more robust to properly function on different window managers and was imperative to use GOO with KDE4. GOO 0.7 now supports any OpenOffice related task from installing, reinstalling, and adding further OpenOffice locales to completely uninstalling OpenOffice.

So, are these versions final? Well, I often thought so, but then something new popped up. Plus, the next major version of the best desktop environment is around the corner. Thank God, Tex is a KDE fan.

Hopefully AL and GOO will be useful to:
* Honor the great work of all the translators and stimulate others to join in, now that they can apply their translations easily.
* Spread PCLinuxOS around the Globe and provide many more people access to this fantastic OS in their native language.
* Make many new non-English speaking users join the PCLinuxOS forums so we can benefit from their new ideas to make PCLinuxOS even better.
* Add only a tiny script fitting on any LiveCD to provide always up-to-date access to gigabytes of language data, avoiding the need to pack them on a CD/DVD where they could be outdated after some time.
* Easily and quickly generate localized remasters of PCLinuxOS.
* Easily setup or customize OpenOffice.

**CONCLUSION:**

Localization only applies already existing language information and AL is just a user-friendly interface for the required steps, that's all. Considering that localization and support for internationalization virtually did not exist before in PCLinuxOS (except for some special community remasters), it is quite amazing to see how much can be achieved by simply applying existing information.

I am very grateful for all the positive feedback in the forums which helped make AL and GOO better meet the needs of the PCLinuxOS users. To hear that AL works well, and that it will help promoting PCLinuxOS to the non-English speaking community, is the biggest thank you I could ever receive!

Finally, I want to give special thanks to Neal and Tex, their patience, testing and support was essential to provide the PCLinuxOS users AL and GOO in its present form, radically simple applications.

Have fun!
-pinoc
since most PCLinuxOS users hail from the English-speaking world, I've invited members of the international community to update the rest of us on what kind of activities are going on in their corners of the PCLinuxOS world. With the addition of pinoc's addlocale utility, it's likely that the international community will continue to grow, as more and more users now have the option of running PCLinuxOS in their native language.

If you'd like to see your international community highlighted in the magazine, send your article or report to the PCLinuxOS Magazine Chief Editor via PM in the PCLinuxOS Forum. Submissions should be made in English. Do not worry about the quality of your English text; the magazine staff will help ensure that it meets all publication guidelines and specifications.
- Paul Arnot, PCLinuxOS Magazine Chief Editor.

PCLinuxOS Serbian Community :: PCLinux.in.rs by Slaviša Milojković (a.k.a., Slax)

We are probably one of the smallest and youngest PCLinuxOS international communities. I was a long time Gentoo user, before I found out about PCLinuxOS. I immediately fell in love with it. PCLinuxOS had almost everything I wanted a distro to have, right out of the box.

So I started a local community about a year ago, since there was none for Serbian language speaking users.

Through the last year we came a long way, and now there are about 100 registered users. Of course, there are users from all of the Balkan region including Croatia, Montenegro, Macedonia and Bosnia. Every new member can expect a helping hand from other members, and we also encourage all Linux users from this region to join us, and if he's willing, to participate in community projects.

Users that most contributed and that I would like to mention are: jogurtmen, trayan, simke, laki71, acinic, and highlander, among others.

Currently, there is a Serbian translation for the GetOpenOffice, update-notifier and addlocale community projects. One of our users, Bocke, packaged the Hedgewars game, and soon it will be added to the repos. You can get it here.

Also we are working on a custom Serbian localized gnome distro called "Vilenjak". The artwork was done by Miloš Miladinović. You can view some of his art here:

There are several open source projects worth mentioning from the local authors.

First I would like to point out that Lancelot was a finalist for the sourceforge best open source project for 2009 and one of the winning QtCentre Programming Contest 2008. Lancelot is an application launcher menu (or ALI) for KDE 4, designed to provide a place from which all your jobs begin. It provides quick access to applications, places, documents, contacts, and system information. Project page is located here and the author is Ivan Čukić.
International Community Updates

Below: Vilenjak KDM and Desktop

Above: Lancelot and Lavirinto3D
Next I would like to mention Pro3x Community Edition, financing software for small companies. It allows you to manage clients, invoices and many other financial tasks. The author is Aleksandar Zgonjan, from Croatia.

Last, but not the least, is the Java game called Lavirinto3D. Authors are Zoran Cirkovi, Nenad Novkovi and Dejan Iliji. You can figure out what the game is about, by downloading it from Sourceforge. It is very addictive and fun to play. Gameplay video can be found here.

Well, that is all for now from the PCLinuxOS fans from this part of the world :)

PCLinuxOS Dutch Community :: PCLinuxOS.nl by DutchWolfie

Most of you will know the Netherlands as the country where Dutch is the native tongue, but Dutch is also spoken in the northern part of Belgium (Flanders). A total of 20 million people speak Dutch, so our community is an international community of 550 members with Dutch and Belgian admins, mods and users.

How It All Started

In November 2006, Mike (NewMikey) and Jos (DutchWolfie) set up a forum to support Dutch speaking PCLinuxOS users, and NewMikey rolled out a localized PCLinuxOS remaster. It may seems strange to some Linux users, but quite a lot of people have problems with English-based software and the localized remaster was a big success. Success means more users, more users means more support and since the release of PCLinuxOS 2007, the Dutch community has grown significantly.

What Do We Do Nowadays

The core business is of course maintaining an active forum and proving the much needed info for new users. Alain J. Baudrez (Wamukota) created a Dutch 'Get started with PCLinuxOS' tutorial, along with some basic Linux tips on the Dutch website. DutchWolfie added a Google Map so that new users can look-up a nearby PCLinuxOS user if help is needed. Wim (JohnW_57) is known as mod on the regular IRC channels, and both he and Jan (Smurfslower) are also know for their outstanding support on these channels and in testing for development. Both are team members who joined us very early on, since last year we added two new members to the PCLinuxOS.NL team. Ed (DeBaas) and Oliver (Oli4) have expanded the Mods, and are regular visitors of the international PCLinuxOS forum, acting as a go between for those users who don't speak English. NewMikey created a special remaster aimed at the photography fan.

There is no need to create a localized Dutch version of the 2009, thanks to pinoc's AddLocale tool. He created a great piece of software, and it helps us a lot. Thank you, pinoc.
As PCLinuxOS is broadening its horizons with Gnome, XFCE, LXDE and other community remasters, we recently opened new forums for them.

**Our Long-Term Plans**

We can state that our community has finally mustered a crew of enthusiastic PCLinuxOS users, so that we now have a solid base to expand our activities. The first new item is the translation of the PCLinuxOS Magazine to Dutch and to get a "video" handbook out on our site as well.

**PCLinuxOS German Community :: PCLOS.de by maik3531**

Personally, I have been with PCLinuxOS since 0.92/0.93 because I had less success with other distributions. After a series of tries to get SuSE Linux running in a decent manner, I finally purchased a Xandros Desktop OS 3, which was not even capable to play several songs one after the other. Printers were another problem area, newer packages were available, but Xandros did not include them. When starting a support request (I had bought 3 of them with the package), I was told that these newer packages were not included because Debian considered them not stable. On a further inquiry with respect to other programs, stable according to Debian, I was advised to purchase a newer version of Xandros.

Having expressed my disappointment of my past experiences in several forums, I also asked for a recommended Linux distro. Almost everybody wrote that Linux is Linux, and I should teach myself compiling and installing any programs myself. Only one user referred me to PCLinuxOS, described it as having a good hardware detection and that there was also a German remaster available. After a successful download and installation of the CD, I was thrilled from the start. The only device which did not work, and despite of using manufacturer drivers, was my HL-1230 printer. For this reason I registered myself on www.pclinuxos.de.

Hence, my first post was the question how to get my printer running. A user named asaf provided me a dummy RPM, which made my printer work. All my hardware worked perfectly fine now, the people in the forum were more than friendly, there was no RTFM, and there were many altruistic users ready to help. Lars always paid attention to maintain a friendly tone in the forum. For many years linudoc made remaster of outstanding quality. Asaf - and later I myself - provided RPMs, if this was necessary or requested. Hamsta provided support in the German IRC, while LinuxFanatic and some others continuously wrote manuals or provided guidance and assistance in the forum. There were also a few user which were very skilled in scripting, e.g. dosenfleisch or flux.

At the time I joined, the forum had approximately 120 registered users, and there were more than 3000 when pclinuxos.de was closed. This obviously included some guys predominantly reading the forum and some others possibly never registered because they did not have
any issues to be resolved. In this sense, I have seen and participated in the constant growth of PCLinuxOS. I got so used to this distro that I cannot live without it any more.

The closure of the German forum was a very bitter pill for all of us. I would like to express my sincere acknowledgment to both, all former PCLinuxOS.de users as well as our American colleagues for the friendly admission to their forums. I also do not want to speak about the reasons for the closure of the German forum. Lars had his reasons. The new PCLOS forum attempts to continue the work of the old forum, and tries to provide new German-speaking users a portal where they can get help in their native language. Whether all of this will work out as planned is difficult to say at this moment, but surely the administrators and moderators will try their best to get everything running again as in the old days.

Portuguese PCLinuxOS Community ::
www.pclinuxos.com/br/site/
by edukator

Hello. I'm edukator from the Portuguese PCLinuxOS Forum. The Portuguese language is the official by several country's like Portugal (Europe), Brazil (South America), Angola, Moçambique, Guiné, Cabo-verde, and São-Tomé (Africa), and with a big influence in Timor, Macau and Goa (Asia). According with Wikipedia, the Portuguese Language "is one of the world's major languages, ranked 6th according to number of native speakers....".

Nevertheless, the Portuguese forum has a rather low activity. So what is the problem and what is the solution?! First, many of us prefer to search and post in the main PCLinuxOS forum, where all the PCLinuxOS Gurus are, and its easier and faster to get the right help to our question/problem. Second, there is now a PCLinuxOS Portuguese Forum (From Brazil), with good activity and visited by many and many PCLinuxOS lovers. Third, PCLinuxOS as a great activity in other Portuguese hardware forums.

With the new application addlocale and the future KDE4 PCLinuxOS release, there is a great opportunity to see more and more Portuguese users in the forum. If you speak Portuguese and need help to change PCLinuxOS to Portuguese, please see this post.

There are some old users like me (edukator) and luikki and some new users like Ra7or, kuruka and many, many others over the world. I also think its very important to have a moderator in each PCLinuxOS International forum like the French German, Hebrew and Polish did. With a moderator, its easier to organize the forum and is a reference for the new users.

If you don't speak/write Portuguese but still want to help in the Portuguese Forum, you can also write in English, and I (or another Portuguese user) will reply your post with a Portuguese translation - but please don't use the online translation software (like Google Translator) to translate a big article or a complex text.

Best regards and good holidays to all.
Creating a Favorite Applications Menu

Updated and Revised by Andrew Strick (Stricktoo) Based on the original article by Pam Dougan in the April 2007 issue of PCLinuxOS Magazine

“I spend time in the Forums, just like everyone else, and while I was there I saw a Post asking about a Favorite Applications shortcut menu. We all have a few applications we use almost all the time, but don’t want to clutter up our panels or desktop with all those icons. I read the reply from Pastor Ed and wanted to share it with you. His method places a sub-menu in the KDE menu.”

METHOD #1

We’ll begin by bringing up the Menu Editor by right clicking on the KDE Menu icon and selecting Menu Editor from the context menu.

Next, we’ll create a new submenu, either by using File > New Submenu or clicking on the New Submenu icon on the toolbar. We’ll call our submenu MyFaves. As far as placement goes, we could make MyFaves a main menu if we really wanted to. But since we’d prefer to keep it out of sight we’ll place it somewhere else, such as the More Applications menu.
The new **MyFaves** submenu.

Before we start adding applications to **MyFaves** we'll take a moment to select a new icon. We'll click on the current icon (the yellow-ish open box).

This will bring up the standard KDE select new icon dialog. The nice, shiny **applixware A** looks nice, so we'll go with that.

The result:
Okay, now we can start adding some applications to **MyFaves**. There are three ways of doing this. One is to use **File > New Item**. This method takes some time and effort, because it requires you to create the item from scratch by entering the name, command and desired icon. Of course, it’s not really that much of a hassle, but since there are simpler ways of getting what we want, we won't bother with it.

The second method is to drag an application from another submenu by holding down the left mouse button and pulling it up to **MyFaves**. When we do this we have to make sure that the squiggly line representing our application is under **MyFaves** and is indented. If it’s not we might wind up placing the application under another submenu or in the main body of More Applications.

The final method is to copy an application from one submenu to another. To copy an application, we can either select it and then use **Edit > Copy**, or we can just right click on it and select **Copy** from the context menu.

We'll navigate back to **MyFaves** and paste the application (**Edit > Paste** or **Right Click > Paste**).
Flashback: Creating a Favorite Applications Menu

The result:

Since we've placed the copy in a new submenu we can remove the suffix without any issues.

Now, one thing to note is that "-2" has been automatically appended to the copied entries to prevent them from overwriting the originals.

Now we'll save the changes to the KMenu by clicking the Save icon in the toolbar (the one that looks like a little floppy disk). Alternatively we could go to File > Save, or use the shortcut (Ctrl+S).
Now, having a MyFaves menu isn't really going to do us a whole lot of good if we have to keep clicking on the KMenu to get to it. Fortunately for us, KDE allows us to place a link to any KMenu submenu on the panel.

All that we have to do is right click on the panel to bring up a context menu, select add Add Application to Menu and navigate to MyFaves. Then we just have to click on Add This Menu. {NOTE: for some inexplicable reason I couldn't get the changes to the KMenu to save, so I had to pick another menu to illustrate this step.}

The result:

![Menu screenshot showing MyFaves and associated applications]

**Method #2**

We can achieve similar results by adding shortcuts to a folder and then adding the folder to the panel.

We need a new folder, so we'll make one by right clicking on the desktop and going to Create New > Folder.

![Folder creation screenshot]

We'll again call it MyFaves.

![Folder contents screenshot]

The result:

![Folder contents screenshot with MyFaves and associated applications]
Flashback: Creating a Favorite Applications Menu

Now we'll open the folder and bring up the Menu Editor, placing them close together.

Next we'll add applications to the folder by dragging them from the KMenu into the folder.

When we let go of the left mouse button, we're presented with a dialog box that asks us whether we want to copy the application launcher or just create a link to it. There really isn't much difference between the two options, so we'll just pick Link Here.

The MyFaves folder now contains a shortcut for Firefox.

Once we're done adding applications to the folder, we can close it and exit out of the Menu Editor.

So, we currently have a folder full of shortcuts just sitting on our desktop. Now what?

Now we add it to our panel and create a convenient menu. All that we need to do is drag the folder over the panel and let go of the mouse button. When we do that, we'll see a context menu asking if we want to Add MyFaves as a File Manager URL or as a QuickBrowser. We want to add it as a QuickBrowser (a File Manager URL will just open MyFaves in Konqueror; QuickBrowser will create a pop-up menu).
Flashback: Creating a Favorite Applications Menu

Our new **QuickBrowser** menu:

We can even change the icon if we want. We can just right click on the **MyFaves** icon and choose **Configure**...

...Click on the current icon...

...And pick our new icon.

Our new icon:

And that's all that there is to it.

**A NOTE FROM ANDREW:**

Personally, I prefer **Method #1** to **Method #2**, for a couple of reasons. With **Method #1** you can organize the menu any way you want and add separators; if you
have a lot of applications you could even create submenus. With #2 the menu is organized in whichever way you have Konqueror set to sort folder contents (e.g. alphabetically or by date). Also, the menu created by #2 includes the title of the folder and the Open in File Manager and Open in Terminal options. Finally, you have to keep the folder; if you delete it, here's what will happen.

Of course, you could make it hidden by appending a dot to the folder name (MyFaves becomes .MyFaves), but then you have to remember where you put it and be careful not to delete it... Well, anyway, I prefer to just make a new submenu and be done with it.

**CONCLUSION:**

Using a Favorites menu to quickly access your most used programs is a great way to keep your panel clean and organized. I've never really minded clutter on my panel and consequently I never really considered a Favorites menu until I reread the original article. Now I'm hooked and my desktop has never looked better!

*Thank you to Pastor Ed for the original suggestion in the Forum, and to Pam Dougan for the original article.*
Welcome to the Wiki Wicket, a column of the PCLinuxOS Magazine that features entries from the PCLinuxOS Wiki. This month, we are featuring an entry from the "Living Wiki" on MyPCLinuxOS. While there are a few different Firefox add-ons that allow you to check and monitor your Gmail accounts, the method highlighted in this article isn't tied specifically to Firefox. And, while the Firefox add-ons require that Firefox be running for you to check and monitor your Gmail accounts, this method works whether Firefox is running or not. If, however, you are using a shared computer, this method might sacrifice some email privacy. It is, however, excellent for use on a computer where you are the only user. -- Paul Arnot, Chief Editor.

Hi Everyone!

I will try to show you how to configure CheckGmail panel tray tool so it would inform you about new mail.

The things I love about CheckGmail:

1. Checks your Gmail account at user-specified intervals (usually every few seconds).
2. Notifies you about new mail with:
   a) Sound.
   b) Tiny and discreet pop-up window (appears for a few seconds and then disappears).
   c) Tray icon changes.
3. Gives you direct access to your Gmail account by just clicking on the CheckGmail icon.
4. Informs you about:
   a) How many unread messages you have.
   b) Who is the sender of the message.
   c) Subject of the messages.
   d) First line of the message content.
5. It does not download or open any messages; it just informs you about them.

I will sometimes use the command line (CLI) this how-to, but don't let that scare you; I will explain every single step.

The target audience for this tutorial is new users.

There are few things I assume you have done before following this tutorial:

1. Installed PCLinuxOS.
2. Configured your internet connection.
3. Fully upgraded the system.
4. Setup the graphical server (X Window System).
5. Rebooted.

Once all those things are done, follow me with these simple steps.
I - INSTALLING CHECKGMAIL:

1. Open a Konsole window and get root privileges:
   a) Type in `su` and press [ENTER].
   b) Type in root password and press [ENTER].
   c) Type in `apt-get install --yes checkgmail` and press [ENTER].

2. Wait until the install process is finished.

3. Once you have CheckGmail installed go back to normal user mode and close Konsole, by doing the following:
   a) Type in `exit` and press [ENTER]
   b) Close the Konsole window

II - CREATING ICON FOR CHECKGMAIL/AUTOSTARTING CHECKGMAIL

1. Create a CheckGmail shortcut icon:
   a) Right click on the Desktop.
   b) Choose Create New.

   c) Choose Link to Application.
2. A new window will come up:
   a) Type in CheckGmail in the name box.
   b) Click on the blue gear icon.
   c) Type in "ema" (without the quotes) in the search box, then click on the email icon and press "OK".
   d) Click on the Application tab and type `checkgmail --no_cookies` in the Command box.
   e) Click OK and notice that somewhere on the desktop your new checkgmail icon was created.

3. Now, we need to set up checkgmail to automatically start whenever the KDE desktop is loaded:
   a) Right click on the new CheckGmail icon on your desktop and choose "Cut" from the menu.
   b) Open konqueror and in the address bar type in "/" (again, without the quotes).
   c) Click on the View button in Konqueror's menu bar.
   d) Make sure that Show Hidden Files option is ticked.
e) Navigate to `/home/user/.kde/Autostart` (where "user" is your username).

{Editor's Note: alternatively, you can simply bring up your /home directory. As long as the "Show Hidden Files" option is checked, as indicated above, you will find the .kde folder. Double click that folder, and navigate to the Autostart folder.}

f) Right click inside this folder and choose "Paste File" from the menu

{Editor's Note: you can also do one of two other things here, should you not wish to reboot your computer. First, you can simply double-click the checkgmail icon in the ".kde/Autostart" folder, and this will launch checkgmail immediately. Your second additional option would be to hold down Ctrl + ALT + Backspace. This will restart KDE without completely rebooting your computer. Either of the alternative methods work equally well.}

III - Configuring CheckGmail

1. Notice that a new icon - the checkgmail icon - appears in the panel tray after KDE is loaded.
2. Right click on this new icon and choose "Preferences."

![Check mail Preferences](image)

3. The checkgmail Preferences dialog box will appear (the image below is only a small section of the dialog box).

![Login details](image)

4. Adjust the settings to suit your needs.
   a) Username: type in your Gmail login
   b) Password: type in your Gmail password
   c) Save password: tick this box
   d) Language: choose your language from the list
   e) Command on tray click: 
      `/usr/bin/mozilla-firefox %u`
   f) Command on new mail: play -v 0.4
      `/path/to/wav/file/Gmail-Notify.wav`
      where "play" is a console media player, "-v 0.4" is a volume of the played track and
      `/path/to/wav/file/` is a path to the sound that you want to use as a Gmail notification sound.
   g) Command on no mail: didn't find anything that I could use in here.
   h) Check Gmail every: Gmail will be checked for new mail every XX seconds, where XX is the value that you set.
   i) 24 hour clock: Tick or untick it depending on what you prefer (11 am / 11 pm or 11 and 23 o'clock).
   j) Archive also marks: If you archive a message in your gmail account it won’t be shown as unread.
   k) Custom icons: I wouldn’t touch this, because it can get messy
   l) Show new mail pop-up: Here you can set how long a little window with a new mail info will be seen on your desktop.
   n) Set tray background: Match the background of the tray icon to the color of your panel; it won’t be perfect, but at least it's not a white square.
5. Click on the OK button in the CheckGmail preferences box.

6. Click on the CheckGmail icon.

7. Firefox should come up and log you straight into your Gmail account.

8. Create new message and send it to yourself.

9. Reboot your system to test the settings after startup.

{Editor's Note: alternatively, you can simply restart KDE by pressing Ctrl + ALT + Backspace, should you not wish to reboot your computer. Also, I skipped this step when I tried it out, and everything works -- and continues to work -- just fine.}

### Konqueror Korner: Add an Option to Open All Files With a Text Editor.

When you are browsing, you often want to read the contents of a text file that is not associated to any particular application. In that case, you can add a service menu to open everything with your favourite text editor. (This will not associate the file with the text editor; it will just give you the option to read or edit it when you choose to).

Create a text file in

```bash
~/.kde/share/konqueror/servicemenus
```

and name it after your favorite text editor (in this example, kate), followed by the extension “desktop” (for example: “kate.desktop” or “open_with_kate.desktop”).

Open the file and paste:

```
[Desktop Entry]
Actions=Kate
ServiceTypes=all/allfiles
X-KDE-Priority=TopLevel

[Desktop Action OpenWithKate]
Name=Kate
Icon=kate
Exec=kate %u
```

This is particularly useful when trying to open a .desktop file, which cannot be associated (as far as I know) to a text editor or when trying to view a text file which has no extension (for example, the “install” text files in a source tarball).
10 Commandments for Linux Users

Author Unknown
Submitted by Texstar

Number One
Thou shalt not log in as root.
Use su- for administrative tasks.

Number Two
Thou shalt use the package manager when possible.
Sometimes installing from source code can't be avoided, but when you use your distro's package manager to manage to install software, you can also use it to update and remove it. This is one of the main strengths of Linux.

Number Three
Thou shalt be a part of the community.
Freely give what you have received for free. Offer help and advice whenever you can.

Number Four
Thou shalt read documentation and man pages.
Always read the documentation. The people who wrote the software tried to anticipate your questions, and provided answers before you asked.

Number Five
Thou shalt use the available support system.
Switching to Linux can be tough. It can be frustrating, but there are a lot of people out there who want to help you. Let them.

Number Six
Thou shalt search.
In most cases, your question or problem has already been addressed. Try to find the answers that are already out there before asking someone to provide a new one.

Number Seven
Thou shalt explore.
Linux opens a whole new world of options and possibilities. Try everything you can.

Number Eight
Thou shalt use the command line.
Especially when it comes to configuration, use the GUI tools to get your system working, but get to know the command line versions as well. In many cases, the command line is the only way to use some of the more advanced features.

Number Nine
Thou shalt not try to recreate Windows.
Linux is not meant to be a clone of Windows. It's different. Embrace and appreciate the differences.
and last (but not least)...

Number Ten
Thou shalt not give up
I tried several distributions before I found one I liked. I still try other distros from time to time. I also tried several different programs to serve one purpose before settling on what I use now (amarok, xmm, beep, exaile for music - azureus, ktorrent, deluge for bittorrents). If you don't like the defaults, remember that you can change almost everything to suit you.

Konqueror Korner: Customizing Konqueror
Here is a list of only some of the innumerable options to customize Konqueror:

CLOSE TAB ON MIDDLE CLICK IN KONQUEROR
Use the following command:

```
kwriteconfig --file konquerorrc --group "FMSettings" --key MouseMiddleClickClosesTab --type bool true
```

OPTIMIZE THE KMENU

Disabling Category Titles in K Menu
To disable the "All Applications", "Actions" and "Last Used"/"Most Used" titles in KMenu, use the following command:

```
kwriteconfig --file kickerrc --group menus -key ShowMenuTitles --type bool false
```

You need to restart kicker for the changes to apply. To do this you can use:

```
dcop kicker Panel restart
```

HIDE "NEW TAB" AND "CLOSE TAB" FROM THE TAB BAR IN KONQUEROR

Use the following commands:

```
kwriteconfig --file konquerorrc --group FMSettings --key AddTabButton --type bool false
```

```
kwriteconfig --file konquerorrc --group FMSettings --key CloseTabButton --type bool false
```
Behind the Scenes

An Interview With a Senior Administrator - Old-Polack

by Paul Arnote

This month, we will take you "behind the scenes" with an interview of one of the senior administrators that help keep PCLinuxOS running. Old-Polack was asked a set of questions, designed to allow members of the PCLinuxOS community to learn more about him.

Q: Can you introduce yourself? (Forum name, real name, occupation, where you live, marital status, pets)

Old-Polack: What's to introduce? I'm "The Old-Polack". I've been "The Polack" since a was a kid. Now I'm much older. I have friends, that have known me most of my life, that couldn't tell you my real name, if their life depended on it. Neither of my parents ever called me by my given name, neither of my wives, nor my children, nor grandchildren. Only my paternal grandparents ever did, and then as a diminutive.

I've been mostly self employed, having only three jobs where I worked for others, when I was a teenager, until I was 22, when I started my own companies. I've been a HVAC contractor, building contractor, licensed electrician, heat treat furnace designer, composite plastics engineer, custom car builder, racing boat designer and parts manufacturer, aircraft parts manufacturer, commercial and fine artist, engineering consultant, and probably a few things that defy proper descriptions. I used to live about 40 miles from nowhere, where I raised horses, cattle, and dogs, as a get away from the formal jobs. I've pretty much done whatever interested me at any given time.

I was born in Columbus Ohio, but spent most of my life in Illinois, presently living just outside of Rockford, IL. I've been married twice, presently divorced, and just bought a house, where I live with my next to youngest son, and his two children.
I have a cat that adopted me, after first hating me, hissing and clawing at me whenever I came near. I don't know where she came from, only that I'd see her hanging around the yard. Then one day she walked in through the open door, laid down on my bed, and has lived with me ever since. She never told me her name, so I call her cat. I also have five cockatiels. The cat must think she's one of them, as she now sits on my shoulder, when I'm online typing, having seen the birds do that first. The cat is as weird and crazy as I am, so we're a good match.

Q: How and when did you get started with computers?

Old-Polack: When my father died, he had a TRS 80 that held all of his company's records. I had to learn how to run it, then crack all his passwords and such, to get at the records, to keep the company running. My first "modern" computer was purchased in 1997, a Sony with a Pentium 200 MMX CPU, with Windows 95 OSR2 installed. It was overpriced, with almost no capacity for upgrading. Six months after it's purchase I built two computers, one of which I've been upgrading, for myself, ever since, and the other I gave to one of my grandsons, after he installed Mandrake 9.1 on it, on his own, on the sneak, without help, one week before his sixth birthday. It seemed appropriate at the time. I've been building computers for myself, family, friends, and friends of friends, ever since. All have had Linux installed.

Q: When did you get interested in Linux and why?

Old-Polack: After building the first two computers, and installing copies of the Windows 95 OSR2 on them, someone pointed out that that was illegal. I didn't know. I figured I'd paid for it, so I owned what I paid for. When it was fully explained that the OS was only licensed, and for only one copy, I set out to buy a couple of copies of Windows 98. An old guy at Best Buy pointed out that I could buy a Linux distribution, and would actually own it, and could install it on as many machines as I wanted, including mine, friend's machines, and those of total strangers, if I wished, as well as give copies of the installation disks to anyone I wished, and do so legally. The boxed set was $30.00, as opposed to the $100.00 each, for the two copies of Windows I had set out to purchase, so it seemed like a deal. I've been using Linux ever since.

Q: What Linux distro did you start with?

Old-Polack: The first boxed set was Mandrake 6.0. I installed it, and ran it for a while, but there were things about it I didn't care for. While discussing it's shortcomings with someone, it was suggested I try SuSE, and he let me run it on one of his machines for a while. I liked it better than Mandrake, so then purchased a boxed set of SuSE 6.4. I still have both of those boxed sets. I stayed with SuSE, as my main desktop installation, for the next eight years, but always had multi boot set ups, where I could try other distributions. At one time I had over twenty Linux distributions on one machine. Somewhere about that time, I reached the conclusion that Linux is Linux, and if you can run one distribution, you can run any other. At that point I cut way back on my total installations.
Q: When did you join PCLinuxOS?

Old-Polack: Join? I've installed and used PCLOS since the first public beta release. After having run Mandrake, as a second OS, along with the Texstar packages, to correct the deficiencies of the official Mandrake releases, when Bill (Texstar) stopped doing the Mandrake packages and created PCLinuxOS, I just followed along. PCLOS has been on my machine, as the second "preferred" OS, since then. I joined the forum when the 2007 release was in the early TR stages, to help straighten out a problem with hardware recognition for a MB RAID controller I had at the time. I didn't do forums up until that time, and never expected to stick around, once the problem was sorted. While waiting to test whatever the dev team came up with next, for that problem controller, I saw some posted problems going unanswered, so I answered some of them, just to kill some time. Funny how that turned out, as I'm still here, and now part of the team, with the PCLinuxOS variants as my only installed systems. Currently I have eight installed, from a pre 2007 TR4, to the newest 2009.2 release, all fully upgraded, all running without problems.

Q: What led you to PCLinuxOS?

Old-Polack: In a word, Bill.

Q: How many hours a week do you estimate that you spend working as a PCLinuxOS administrator?

Old-Polack: Way more than I should, and not as much as I'd like. Real life interferes in a big way.

Q: What one thing is the most challenging thing you have to deal with as an administrator?

Old-Polack: The people, not regulars, that think they can say and do whatever they like, on our forum, without regard to the rest of the community. We try to welcome everyone, but some people seem to have no concept of manners, or respect for others. I hate to have to remove someone's post, or worse yet, ban them from the forum, but there are those hard headed individuals that simply leave no other choice. They make it unpleasant for everyone, and disrupt the otherwise friendly and harmonious nature of the forum that we've all worked so hard to achieve.

Q: What is the most rewarding thing about being a PCLinuxOS Forum administrator?

Old-Polack: The vast majority of the community, and the way they pitch in to help each other, and the distribution, to be even better than it was the day before. We've got some really great people gathered here, most trying to give back something, as a thank you for the joy they've received running PCLinuxOS. Being an integral part of that community, and working with it's members, is it's own reward.

Q: What one song best describes your style in the forum?

Old-Polack: Send in the Clowns?
Q: What one song best describes your personality?

**Old-Polack:** Definitely, Send in the Clowns.

Q: In the animal kingdom, which animal best represents you?

**Old-Polack:** A mutt puppy.

Q: What parting advice or words of wisdom would you like to leave the PCLinuxOS magazine readers?

**Old-Polack:** That from which my sig derives.

Of what use be there for joy, if not for the sharing thereof? Is not a thing shared of greater worth, than that same thing, hoarded for it's own sake? Is not sharing then, the true essence of joy? Unshared, one's joy is but a passing moment of a selfish existence. Shared, joy is that one true value of life, which is increased, in direct proportion to the degree with which it is shared. Joy is always best savored while shared.

---

**KDE Korner: A Short List of Handy KDE Applications**

Here is a list of wonderful applications that can make your life easier in KDE:

**Katapult:** allows you to run an application by pressing a key combination (for example: ALT+spacebar) and typing the first letters of the application's name (as it appears in the KMenu)

**Kshowmail:** allows you to check multiple mail accounts. You can use filters, choose to remove selected messages from the server, and much more

**Basket:** an incredibly powerful and customizable application to take notes, insert images, etc. It has so many options that it sometimes feels like you are in OpenOffice

**Ksnapshot:** lets you take screenshots, both full-screen and partial

**Kdocker:** allows you to send a running application to the system tray, temporarily hiding it from the taskbar
Installing PCLinuxOS Without a CD/DVD

by Sproggy

This guide is for people who want to install PCLinuxOS but can't use the LiveCD approach, either because they don't have a CD drive or don't have or want to use a spare CD. This uses UNetbootin to automate and simplify the process of performing a no-CD installation from Windows.

It is a good idea to run the disk defragmenter in Windows a couple of times before shrinking the Windows partitions. This is crucial, as files can be lost otherwise.

Note that if you have a USB drive handy, and your computer can boot from USB, the LiveUSB guide (which instead creates a liveUSB drive to boot and install from) will likely work better.

WHAT THIS GUIDE DOES:

It basically adds a boot entry to Windows that allows you to boot into the PCLinuxOS Live environment (although PCLinuxOS is loaded from the hard drive, not CD), from which you can either do a standard installation or just use it in Live mode.

REQUIREMENTS:

* Windows 2000 or above (Windows 95/98/ME are not supported)
* Windows is NOT strictly required; UNetbootin can also be run from an existing Linux install, or can create bootable liveUSB drives. See the UNetbootin site for details/instructions; however this guide will cover installation from Windows

STEP 1: PARTITIONING YOUR DISKS

Note: You can also skip this step if you only want to use PCLinuxOS in Live mode, already have spare partitions into which you can install PCLinuxOS into, or will be booting PCLinuxOS in "copy2ram" mode (but you'll need at least 1GB RAM for that). This step resizes your Windows install and creates partitions into which PCLinuxOS can be installed (since you will be unable to resize the partition equivalent to Windows C:\ while in the UNetbootin-booted PCLinuxOS Live environment). Additionally, this step is documented well, and with screenshots, at HowtoForge, so you may want to read that. Follow only that page, though, since the rest of the guide is for Ubuntu and Fedora installation.

1. Download UNetbootin here.

2. Run UNetboootin, and select "Parted Magic" from the distribution selector (see screen shot below). Wait as UNetbootin downloads and installs Parted Magic. Once done, you'll be prompted to reboot.

3. After rebooting, select the option labeled "UNetbootin" on the Windows boot menu. This will boot you into an environment from which you can start up GParted. In GParted, shrink your Windows partition using the resize option, then create a new partition in
Installing PCLinuxOS Without a CD/DVD

the free space (which you will be using for PCLinuxOS). After that, reboot, and you'll be prompted to uninstall UNetbootin; click OK and that will undo the changes to the Windows bootloader. {Editor's Note: Vista/Win7 users, refer to the notes at the end of the article for more information about resizing the Vista/Win7 NTFS partitions}

2. Run UNetbootin, and and select a PCLinuxOS ISO file to load within the "disk image" option (see screenshot below), then press OK and wait as the ISO is extracted to your hard drive. Once done installing, you'll be prompted you to reboot; reboot.

**STEP 3: BOOTING AND INSTALLING PCLINUXOS**

1. After rebooting, you'll see a UNetbootin entry in the Windows boot menu. Select that, and it'll boot into the Live environment.

2. Once booted into the PCLinuxOS Live environment, start the installer, then after that everything will go as usual.

**NOTES:**

* If you're running Vista, you may have better luck using its built-in partition manager (diskmgmt.msc) instead; GParted sometimes has issues resizing Vista's NTFS partitions.

* If you want to boot with additional parameters, like "copy2ram", you'll have to either press ESC right as you select the UNetbootin entry (which will let you edit the boot options; copy2ram goes at the end of the

**STEP 2: DOWNLOAD THE UNETBOOTIN PCLINUXOS INSTALLER**

1. If you haven't already done so, download the ISO file for the PCLinuxOS version you wish to install, and download UNetbootin [here].
"kernel" line if you're using it), or you can edit
c:\unetbootin\menu.lst and add the copy2ram and other
options there, towards the end in the line beginning with
"kernel".

MORE:

UNetbootin also supports the installation of many other
distros.

Konqueror Korner: Handling aMule (eMule) Links in Konqueror

If you are surfing the web with konqueror and when
you click an ed2k link (for aMule) nothing happens,
you can do the following.

1) Create a new text file.

2) Open it and append the following:

[Protocol]
exec=/usr/bin/ed2k "%u"
protocol=ed2k
input=none
output=none
helper=true
listing=false
reading=false
writing=false
makedir=false
deleting=false

3) Save it as ed2k.protocol and make it executable.

4) Copy it to /usr/share/services/ (you will need root
privileges).

5) Fully restart konqueror (to be safe: open a terminal
and run killall konqueror)

NOTE: Since aMule 2.2.4, /usr/bin/ed2k has been
replaced with /usr/bin/ed2k-amule. If you are using that
version, change in above line exec=/usr/bin/ed2k
 "%u" to exec=/usr/bin/ed2k-amule "%u"

Disable Archive Expanding In Konqueror's Sidebar

By default, when you install konqueror, archives are
treated as folders in the tree that appears in the
navigation panel. That means that when you open a
folder which has compressed files inside, they will show
in the tree as folders. If you find this feature useless or
annoying, open

~/.kde/share/config/konqsidebartng.rc

and add AT THE BEGINNING of the file:

ShowArchivesAsFolders=false
The Linux Kernel

by BigBearOmaha

I thought we would start on a little discussion about the Linux kernel. Everything that is at the 'guts' of Linux, is in the kernel. I know we have all heard that "Linux" itself is only the kernel, and that GNU applications largely make up the 'rest' of the OS. If that is true, then what exactly is the kernel doing?

The Linux kernel is a meaty piece of coding that essentially tells all of the computer's hardware how to get along, in simplistic terms. It's sort of part traffic cop, part negotiator and part translator.

The code itself comes from a large and varied group of contributors who send in anything as small as a few lines of code as a 'patch' to fix or modify something they found already existing in the kernel, to whole new sections of code to be added to the next version of the kernel.

All of these submissions are sent in by people wanting to volunteer their time and talents, or by people working for companies who actually get paid to contribute to the project. There are lists of contributors that are maintained by the group who maintains the kernel, and this allows the process to be transparent. It lets everyone know who is doing what and how much they are doing.

There are at least twenty seven (27) major companies that contribute to the Linux kernel. IBM, Cisco, and HP are among them, as well as a host of others.

This level of support from established and recognized leaders in the technology world helps to ensure that Linux will be around for a long time and that it is a 'serious' product.

Linus Torvalds, the guy who spearheaded the Linux kernel and brought it to the light of the open source world is employed by Open Source Development Labs as the official maintainer of the Linux kernel. He has the final say so on absolutely everything that makes it into the kernel. Not only that, he is the registered owner of the 'Linux' trademark which keeps mischievous others from doing dastardly deeds in the name of Linux.

One very important thing about the Linux kernel is that it can be modified freely by anyone for their own uses and needs. You can add modules and code in any way you see fit.
fit to take advantage of the true speed and flexibility of Linux. You can customize it to take advantage of the specific processor and memory that is installed on the specific mainboard in that computer if you like. Because the kernel is distributed under the GPL, this also means that your able to access the kernel, make modifications to it, customize it, even edit the source code itself if you are feeling especially techy, without paying a cent to anyone for the privilege of doing so.

The most recent stable kernel is 2.6.30.1. The Linux kernel is in a constant state of evolution and some releases bring about major changes that are industry wide monumental improvements. On the other hand, many of the releases are only cosmetic or bring in small fixes to repair or improve features that you might never 'see' if you weren't told about it.

The Linux kernel is a unique beast. It is an ever changing, open book that anyone with any level of experience can send a contribution to and be a part of. Now, just because anyone can send a contribution, doesn't mean they are all used. Sometimes, often actually, contributions never see the light of day. That doesn't mean people can't contribute again; it just means that this time, it needed more work or wasn't one of the areas they were focusing on.

The Linux kernel is an incredible piece of work. It provides the basis of one of the foremost representatives of open source software. It brings together the experience, talent and knowledge of hundreds (if not thousands) of programmers and scripters, professionals and hobbyists, from around the world into one, highly functioning, technological marvel.

Now you know.
Through the Lens

by Patrick G Horneker

DIGITIZING OLD PHOTOGRAPHS

Photography itself has been around for more than 150 years. Digital cameras were just under development in the late 1990s. During the same time, the image scanner was the peripheral to have if you wanted to digitize a photograph for use in a document, web page, or to store on your hard drive.

Fast forward to today. You can still buy an image scanner, but scanners by themselves are difficult to come by in the retail stores. However, all-in-one devices and digital cameras reduced the need to purchase a separate scanner.

Why am I telling you this? Because the digital camera is not the only way to create digital photographs. If you have a large collection of photographs, an image scanner, be it by itself or as part of an all-in-one device, is a necessity to get that collection onto your hard drive. This has been true since the first scanners came out for Macs and PCs of the early 1990s.

For PCLinuxOS and other Linux distributions (as well as FreeBSD, Solaris, and other UNIX dialects), there is SANE (for Scanner Access Now Easy) for scanner access and support.

PACKAGES YOU NEED TO HAVE INSTALLED

In PCLinuxOS, SANE is a series of RPM packages that need to be installed. If you have the MiniMe flavor of PCLinuxOS, you will need to go into Synaptic and install `saned` and all of its dependencies, including `sane-backends`. These packages provide the basic SANE installation you need to get your scanner working under PCLinuxOS.

If you have a Hewlett-Packard all-in-one device, you will also need to install the `hplip`, `hplip-gui`, `hplip-hpijs` and all of its dependencies, which should include the aforementioned `saned` and `sane-backends` packages.

GET SANED WORKING FIRST

SANE is to Linux what TWAIN is to Windows. SANE is a software layer that is an interface between your scanner and your PCLinuxOS machine. It is responsible for initial setup of scanners (such as uploading of firmware), scanner detection, and acquisition of image data.

Before you can scan anything into your PCLinuxOS machine, you need to make sure your scanner is supported. If you have a Hewlett-Packard All-In-One Device, check with the HPLIP website to see if your all-in-one device is supported with the version of HPLIP installed. This information cannot be found at the SANE Project website.

All applications that involve scanning of images require `saned` to be properly functioning.
The easiest way to configure your scanner is to open the PCLinuxOS Control Center, click on the Hardware tab, then select Set up Scanner.

If you have a Hewlett-Packard all-in-one device, you do not need to click on Set up Scanner. Instead, make sure a print queue has been setup for the device. HPLIP software automatically sets up the SANE backend at the time the print queue has been setup. This is a function of the HPLIP installation utility.

**NOTES FOR PARALLEL PORT SCANNERS**

SANE can only automatically detect SCSI and USB scanners. It cannot automatically detect parallel port scanners. This is due to the design of the SANE library. Fortunately, PCLinuxOS has a way to configure even these scanners, provided that they are supported in the first place.

In this example, I have selected the Hewlett-Packard Scanjet 3200C. This was a scanner that I owned before I got my all-in-one devices.

The highlighted scanner is a parallel port scanner that is known to work with SANE using the sane-umax_pp backend. The 3200C is a rebranded UMAX Astro 1220P scanner, hence the UMAX parallel port backend.

Though I currently have a Hewlett-Packard PSC-2175 with the HPLIP driver providing the SANE backend, I have presented you with the dialog box here to show you that some parallel port scanners can be configured under PCLinuxOS.

SANE was originally designed to work with SCSI-based scanners as the (now ancient) SCSI interface was the only interface for scanner access available to Linux and UNIX users. In order for parallel port devices to work with Linux, drivers called **ppdev** (at the root level) and
parport (at the user level) were loaded first, then SCSI emulation was activated so the scanners could be accessed.

Fortunately for us, USB devices are easily accessed through SANE, thanks in part due to first the SCSI emulation that is part of the USB subsystem, and later due to the udev and HAL subsystems, that are now a part of many Linux distributions, including PCLinuxOS.

Thanks to the user friendly utilities provided with PCLinuxOS Control Center, the user does not need to be concerned about the configuration details.

COMMAND LINE UTILITIES

SANE comes with a couple of useful command line utilities.

sane-find-scanner is useful when you are having trouble detecting your scanner. As the name suggests, this utility attempts to detect scanners connected to your PCLinuxOS machine. [Note: This utility does not detect parallel port scanners, only those connected to SCSI and USB.] Simply open a terminal window and type in sane-find-scanner. The following output should appear.

[patrick@davinci ~]$ sane-find-scanner

# sane-find-scanner will now attempt to detect your scanner. If the
# result is different from what you expected, first make sure your
# scanner is powered up and properly connected to your computer.

# No SCSI scanners found. If you expected something different, make sure that
# you have loaded a kernel SCSI driver for your SCSI adapter.

found USB scanner (vendor=0x03f0 [Hewlett-Packard], product=0x2b11 [PSC 2170 Series]) at libusb:002:005
# Your USB scanner was (probably) detected. It may or may not be supported by
# SANE. Try scanimage -L and read the backend’s manpage.

# Not checking for parallel port scanners.

# Most Scanners connected to the parallel port or other proprietary ports
# can’t be detected by this program.

# You may want to run this program as root to find all devices. Once you
# found the scanner devices, be sure to adjust access permissions as
# necessary.
[patrick@davinci ~]$
NOTES ON THE FOLLOWING SOFTWARE PACKAGES

The following software packages may or may not come with your PCLinuxOS distribution. While PCLinuxOS has its own App Store, which does make life easier for the system maintainer, many of the featured packages here are not yet included for downloading. You will need to use Synaptic to install the featured packages, if they are not already installed on your PCLinuxOS system.

THE XSANE PACKAGE

Used by itself or with the GIMP, this utility was developed as part of the SANE package to provide a graphical interface to the SANE backends.

In this example, I launched xsane by itself, then rearranged the opened windows so you can see all the controls of the program. This is how xsane looks when you first launch the program. This example is for the Hewlett-Packard PSC-2175.

If you have more than one scanner, or a scanner and/or a supported webcam, you will get a menu to choose a device to use before this comes up.

General controls supplied with this program provide control over the image resolution, brightness, contrast, and gamma value, as well as for inverting colors, and resetting default values.

You can also select whether to scan the image as a color image, a greyscale image (for black and white work), or line art (useful for lithographic work). The window on the center displays a histogram for the image.

The window on the right is where the actual scanning work takes place. Here you see what is being scanned, and you can select parts of the image to save. Click on Acquire Preview to get an initial scan of the image you are digitizing.

The lower right hand corner of this window (called the Preview window) contains a magnified view of the image you are scanning. You use this as a tool for precision when selecting parts of the image to use in the final scan.

To create the final scan, click on Scan in the left window (the main window). The output of the scan depends on how you started xsane, and what type of output you have selected. When running as a GIMP plugin, a new GIMP document is opened for editing. By default, the
The built-in image viewer opens up to display the image, where you can then have the option of saving the image. If you do not supply a filename, Xsane will automatically save it as out.pnm in your home directory.

Xsane has support for image printing, faxing, copying and e-mailing as well as creating multi-page PDF documents. Not bad for a simple scanning tool.

Xsane can be installed from Synaptic under the Graphics category.

**Kooka, The KDE Scanning Package**

Yes, Xsane runs fine on KDE, but Kooka was designed to be used with KDE. There are a few differences between Kooka and Xsane.

For starters, this dialog always appears when launching Kooka. Xsane does this only if there is more than one scanning device connected to your PCLinuxOS system. Of course, you can bypass this window if you check "Do not ask on startup again, always use this device".

The designers of Kooka integrated all functionality found in Xsane into one application window instead of using four windows. They did not include the image histogram. However, they did include one click access buttons to optical character recognition, printing, image sizing, rotation and image selection.

The screenshot here is what you get after launching Kooka and selecting your device. In addition to the previously aforementioned features, Kooka includes its own image gallery.
This gallery is internal to Kooka, and if you have your own organized photo collection on your hard drive, you can save images scanned with Kooka to your collection. Unfortunately, it is a tedious task. You must select each entry you wish to save, then select File > Save Image... to save each image to your hard drive.

You can also import images to the built-in gallery.

To scan images, you need to perform a preview scan. This is one thing that was made easier with Kooka than with xsane. The Preview Scan and Final Scan buttons are next to each other in the application window.

After the preview scan, the image comes up in the preview window (shown below). Unlike xsane, there is no automatic control over the brightness and contrast of the image. You can, however, control the contrast and resolution of the final image.

It is here where you select the image you want to be included in the final scan. The best way to select the image is to manually select the area to be included. This means press the left mouse button at the lower right hand corner of the picture, then drag the mouse to the upper left hand corner of the image.

You can also autoselect the image by checking the Active on... box and adjusting the threshold. This may or may not get you the image you want.

Notice that the preview size is labelled Custom. Kooka comes with some presets for common paper and image sizes, selectable from that drop down menu. While this may seem to be an easy way to select the scan area, it is not always the best way.

When you are done, click on Final Scan to scan only the selected area. This scan will appear in the Kooka Gallery where you can print, save to your hard drive, or open it in another program.

After the scanner reads in your photograph, you will be presented with the Save Assistant. This dialog box allows you to choose the image format where you want the final image to be saved as.

Kooka has support for the common JPEG, TIFF, and PNG formats. Kooka also supports the lossless Targa format, originally developed at AT&T for its specialized video boards developed back in the early 1990s. The Targa format is superior when it comes to image quality.
However, the tradeoff is that the file size is quite large when compared to a uncompressed JPEG or TIFF file.

I recommend either the Targa or the TIFF formats if you really cannot compromise the quality of the image for space savings. For everyday photographic work, I would recommend the JPEG format.

Kooka can be installed from **Synaptic** under the **Graphical Desktop/KDE** category.

While you can save images from the application, there is a faster way to retrieve the images from the Kooka gallery. The images are stored in your home directory, and are located at:

```
~/.kde/share/apps/ScanImages
```

and are named **kscan_****.jpeg** where **** is the scan number set by an internal counter for keeping track of how many scans were performed in a Kooka session. If you choose to copy these files to another directory on your hard disk, I recommend copying the files to an empty directory, then renaming the files to something more appropriate before integrating them to your photograph collection.

**VUESCAN**

Vuescan is a commercial product that is a replacement for SANE and its graphical interface, xsane. It has support for many more scanners than the SANE package, but it is well worth the expense if you have a scanner that is not supported by SANE.

There are two versions of this product available: The Standard Edition ($39.99 USD) provides scanning services only, and the Professional Edition ($79.99 USD) provides raw scanning (similar to raw image processing in digital cameras), ICC color profiles, color calibration, and other useful services to photographers.

**WHAT ABOUT FILM SCANNERS?**

The scanning software and the SANE package work with scanners designed for photographs and documents. But what about scanners that scan negatives and slides? This is a more difficult task. Some image scanners come with film adapters to scan in negatives and slides. But what about the dedicated units that do only negatives and slides?
Nikon has several models that work with Linux. The LS30 and LS2000 are SCSI-based models that work flawlessly. The LS4000 and LS8000 work good, but are parallel port models. The LS40 works flawlessly as a USB scanner. However, the support for LS50 and Coolscan models is minimal and untested as of this writing.

The Ion Audio Slides2PC, which is a commercially available product, is a paperweight. It uses a proprietary software designed to work exclusively with Windows. No Mac OS-X version of the driver was ever developed, let alone a driver for Linux.

KDE Korner: A Few Features to Keep In Mind About KDE

- Whenever you open the KDE dialog that lets you browse for a file and open it, that dialog is assigned to the application that launched it. This enables you to customize it according to each specific application. For example, when you choose Configure Desktop > Picture and press the folder icon to the right, you can drag your wallpaper directory to the left panel and choose to show that folder only when opening the dialog through that application, so that the folder will not show on the left panel when you are browsing for a file in OpenOffice, for example.

- You can add extra panel's to your desktop. This is specially useful when you have a big monitor (or a cheap-small-widescreen like I do) and have some extra space to spare.

- There are many alternatives to the default KMenu, such as Kickoff, KBFX and TastyMenu.

- Kicker (the default panel) has many mini-applications which can easily be installed by right clicking on the panel and choosing Add Applet to Panel; try them.
I noticed that CtrlAltDel has made more than 1900 posts in the forum. What a great helper! I also noticed that he signs most of his advice with "Good luck". Now think about it. Would you follow a direction of an Irishman who says it needs luck to work? I might. But I'd probably keep my fingers crossed too.

Rastus wrote in Desktop Hardware
"In the absence of a grown up, I will try and answer your question." Surely there are a couple of grownups in the forum!
Hmmmm..maybe not.

vampirefo in sandbox, "Does she have a sister?" Elsewhere he describes himself as a 1969 Dodge Charger.

Charger Specs
sporty, high performance, extremely durable, on the fast track and trim with rear end lift
Would you trust him with your sister?

rustynail: "It might be a good idea to set up a forum category just for netbooks. Thoughts?"
Here's my thought, "All in favor of taking rustynail's netbook away, say aye. Anybody who thinks gmail is a dog, doesn't need a netbook." rustynail speaks,
"From a personal stand, I have set up a gmail account that goes out and retrieves my company emails."

June 23, 2009, 03:35:23 PM.
Neptune asked, "Is anyone else getting this?"
Nobody got it, nobody gets it and nobody is ever gonna get it. Go on back to your bass fishing and bluegrass music and try to sort it out.
Audio Files

by Paul Arnote

In our comparisons of file formats, this month we will take a look at the more common audio file formats. Hopefully, this brief overview of the different audio file formats will help you figure out which audio file format is best for your intended use.

Just as with graphic file formats (see the July, 2009 issue of PCLinuxOS Magazine), audio formats can employ either **lossy** or **lossless** file compression. With **lossless** data compression, an exact extraction of the original data from the compressed data occurs, without any loss of sound quality. Meanwhile, **lossy** data compression offers an approximate of the original data, sacrificing some of the original sound quality in the quest for better compression rates.

**Sample rate** refers to how many samples are taken per second. It is commonly expressed in Hz, or Hertz, which stands for the number of samples per second. One hertz is, thus, equal to one cycle per second. So, an audio file with a sample rate of 22.5 kHz will make 22,500 samples per second. An audio file with a sample rate of 44.1 kHz will make 44,100 samples per second. DVD audio is commonly done with a sample rate of 48 kHz, or 48,000 samples per seconds.

**Sample depth** refers to how many bits each sample of data occupies. Although it is available at such sample depths of 2, 4, and 8 bits, the 16 bit sample size is most common for accurate sound reproduction, and is used most commonly to save sound files in stereo.

One other term we have to understand is **pulse code modulation**, also referred to as PCM. PCM is a digital representation of an analog signal that is sampled regularly at uniform levels, then quantized (converted) to a binary code that represents the original signal. PCM is the standard for digital audio in the computing world, as well as being commonly used with digital telephone networks and electronic musical keyboards. It exists all around us, forming the foundation for audio (Red Book) CDs, and even for the sound we all hear when we play a DVD in our home DVD players.

So with that taken care of, lets take a look at some of the more common audio file formats.

**AIFF (Audio Interchange File Format)**

This sound file format was co-developed by Apple Computers in 1988, and is based on Electronic Art's IFF (Interchange File Format), which was in wide use on Amiga computers. Most commonly, you will find the AIFF format in use on Apple Macintosh computers. It can usually be recognized by the .aiff or .aif file extension.

Traditionally, the AIFF format is uncompressed. As such, it is considered to be a lossless audio file format. It is frequently used by professional-level audio and video applications. Since it is uncompressed, it is possible to stream multiple audio files from the disk to the application used for playback. Because it is uncompressed, it takes considerable space to save an AIFF file.
One minute of audio will take approximately 10 MB of hard disk space to store, at a sample rate of 44.1 kHz and a sample size of 16 bits. Despite the enormous amount of space it takes to store audio in the AIFF format, you can expect accurate and faithful sound reproduction.

**WAV (Waveform Audio Format)**

WAV, also known as "Audio For Windows," is a format for storing bit-stream audio on PCs, and was developed by Microsoft and IBM. Formally released in 1992, it is very similar to the AIFF format (above) that was co-developed by Apple Computers. It is the main format used to store audio on Microsoft Windows® systems. It is usually recognized by the .wav file extension.

Like the AIFF format, the WAV file is most commonly uncompressed. This makes it a lossless audio file format. WAV files are compatible with Linux and Macintosh operating systems, besides Windows. Due to its lack of compression, WAV files are commonly used by professional users or audio experts to preserve maximum audio quality.

The WAV file format has lost some of its popularity, due to its traditionally uncompressed nature and inherently large file sizes. This makes them an unpopular choice for internet file sharing or transfer. Just as with AIFF files, WAV files take up a lot of space. One minute of audio recorded at 44.1 kHz with a 16-bit sample size will consume approximately 10 MB of disk space. However, its popularity does continue, as the WAV file makes a good choice for first generation audio recordings, which can be edited repeatedly without any loss of quality. It is also popular because of its relatively simple file structure, and because it is familiar to a very large number of computer users. In many cases, the WAV file represents the "least common denominator" when it comes to the exchange of file formats between different applications or operating systems.

One significant limitation of standard WAV files are their limitation to files of no larger than 4 GB. This is due to the use of a 32 bit unsigned integer used to record the file size header. Although this is large enough to store 6.6 hours of audio recorded at 44.1 kHz and 16-bit sample size, it may be necessary at times to exceed this inherent limit. Some programs change this to a 64 bit unsigned integer to circumvent the file size limitation, but it is not yet considered standard implementation of the WAV file format.

In PCLinuxOS, most programs that offer audio file playback will play WAV files.

**MP3 (Moving Pictures Experts Group [MPEG]-1 Audio Layer 3)**

Approved as an ISO/IEC in 1991, the MP3 file format is probably one of the most popular and most used of the current crop of audio file formats. It has become the de facto standard for the vast majority of consumer portable audio players. Besides being widely accepted, one of the biggest attraction to MP3 files is their compression. This compression can, at 128 kHz bit rate
with a 16-bit sample size, can compress the audio information represented by the WAV format in a file 1/10th of the size. This means that one minute of audio recorded in the MP3 format (at 128 kHz bit rate and with a 16-bit sample size) will only occupy approximately 1 MB of disk space, compared to the 10 MB it takes to save the same audio recorded in either the WAV or AIFF file formats.

The trade-off is in the sound quality. MP3 files use a lossy compression algorithm, and is often compared to the JPEG graphics file format. It does this by discarding frequencies that are difficult for the human ear to hear, and recording the remaining frequencies in an efficient manner. At bit rates of 128 kHz and above, it is difficult for many people to discern the loss of quality. And, of course, the higher the audio sample bit rate, the lower the compression, and the better the quality. Thus, an audio sample recorded at the 256 kHz bit rate setting will preserve more of the audio quality of the original than the same recording recorded at the 128 kHz bit rate setting.

Because of the outstanding compression employed by the MP3 file format, it has become a favorite of those who like to exchange and share files on the internet. The smaller file size means quicker downloading and file transfers. However, as with JPEG graphic files, MP3 files will suffer from what is called "generational degredation." This means that re-encoding an MP3 file will cause it to be re-compressed, and even more audio fidelity will be lost. Do this multiple times, and the loss will be significant and noticeable.

The MP3 file format has not cleared the patent hurdles, however. Numerous patents related to the MP3 file format have been filed, and they expire somewhere between 2007 (already expired, for the original MPEG-1 Audio Layer 3 specification) and 2017, depending on which patent is being applied. The Fraunhofer Society, commonly referred to as Fraunhofer IIS, patented the MP3 file format, and is generally considered to be the owner. Licensing for the use of the MP3 file format has generated the Fraunhofer Society €100,000,000 (or over $180,000,000 U.S.) in 2005 alone. Thompson Consumer Electronics also claims to hold the licensing rights on the MP3 file format in the U.S., Japan, Canada, and the EU countries. If only the MP3 patents files by December, 1992 are considered, the MP3 file format may be patent free by December, 2012. Both are known to actively pursue enforcement of the MP3 patents.

The enforcements of these patents on the MP3 format led to the development of other audio file formats in an effort to circumvent the need to license the use of the patents.

Most programs that allow audio playback in PCLinuxOS support the playback of MP3 files.

**OGG (Ogg-Vorbis)**

Stemming from the receipt of a letter from the Fraunhofer Society announcing plans to charge licensing fees for the MP3 format in September, 1998,
the Ogg Vorbis format was born as an open source project to circumvent that licensing. Headed up by the Xiph.org Foundation, the Ogg Vorbis format employs a lossy compression algorithm, and is intended to be an open source replacement for the patent-riddled, proprietary MP3 format.

The first stable (v 1.0) of the software was released in July, 2002. The most recent version of the software, libvorbis, is v 1.2.0, and is the version that is included in the PCLinuxOS repository. Ogg Vorbis files can often be recognized by their .ogg file extension.

The Ogg Vorbis file format is popular among those who support free software. It is free, and unencumbered by patents. Many of its supporters claim that it has a higher sound fidelity, when compared with MP3 files recorded with the same bit rate and sample size. The file format has also become popular in many modern computer games for storing in-game audio.

Listening tests have shown the Ogg Vorbis format to outperform MP3, WMA, and other lossy audio formats across the board, at all sample bit rates and sample sizes, of the competing formats similarly recorded.

Just as with MP3 files, however, the Ogg Vorbis file also suffers from generational degradation, where editing an Ogg Vorbis file, and re-saving it, will result in a loss of audio fidelity. As with MP3 files, doing this several times will result in a noticeable and significant loss of audio quality.

While not as popular as the MP3 format, its popularity is increasing. This is primarily due to the fact the the Ogg Vorbis format can be used free of charge, without the licensing hassles. As a result, personal audio players are appearing on the market that will play Ogg Vorbis encoded files, in addition to the more traditional - and more popular - MP3 encoded files. Some of those devices that are known to play Ogg Vorbis files include the Sandisk's SansaClip (1.01.29 firmware and higher), Sandisk's Sansa Fuze player (1.01.15 firmware update), devices using Google Android, Samsung YP series audio players, iAudio X5, most of the iRiver audio players, to name a few. More audio devices are being added to the list as the file format increases in popularity.

Due to its open source nature, many of the audio playback programs in the PCLinuxOS repository support the playback of Ogg Vorbis files.

**WMA (Windows Media Audio)**

Microsoft created the WMA format in 1999 to circumvent the MP3 licensing issue, and to address perceived deficiencies of the MP3 format. It is a proprietary format that uses lossy compression, and forms a part of the Windows Media Framework. To keep things "simple," the WMA format actually consists of four different codecs: the original WMA format, WMA Professional (supporting multi-channel sound at higher fidelity), WMA Lossless (utilizing lossless compression to improve sound fidelity), and WMA Voice (utilizing
lower sampling bit rates to achieve greater compression). Unfortunately, none of the latter three are compatible with the original WMA format. For this article, we'll restrict our discussion to the original WMA format.

WMA files are often "encapsulated" in the ASF (Advanced Systems Format) container. While WMA files themselves are not "encoded" to provide DRM (Digital Rights Management), it is the ASF container that provides this "functionality."

WMA is one of the most popular audio codecs, presumably due to Windows market share in the computer market. Numerous portable audio player devices exist that allow playback of WMA files. Many home/set-top DVD players also come with the ability to play WMA files, as well.

In PCLinuxOS, there are several programs that can play WMA files - well, the ones unencumbered by DRM, anyways. They include VLC, Mplayer, and XMMS, to name a few.

**FLAC (FREE LOSSLESS AUDIO CODEC)**

FLAC files differ from MP3, Ogg Vorbis, and WMA files in that they employ lossless compression. As a result, a comparable FLAC file will be larger than any of the lossy file formats, but the sound quality will be the same as the source. In fact, many audiophiles frequently "back up" their audio CD collections to FLAC files; then, should anything happen to their audio CDs, they can simply burn another copy - and that copy will have the same quality as the original CD. The compression achieved by the FLAC file can be somewhere in the neighborhood of 30% to 50% of the original size of the CD track.

Another popular use for FLAC files is for transcoding to MP3 files. Because FLAC files use lossless compression, the files can be edited, saved, re-edited, saved again ... and so on, as many times as you want, without any loss of audio quality. Then, once the file is edited to how you want it, it can then be saved as an MP3 file.

As a free and open source codec, there is strong support for FLAC files in Linux. And, the same free and open source nature is gaining some support among portable audio players. Some of these include the SanDisk Sansa Fuze, SanDisk Sansa Clip, Rio Karma, and the iRiver E100.

Started in 2000, the FLAC format is now under the banner of the Xiph.org Foundation, right along side Ogg Vorbis.

FLAC files are also DRM free. In fact, the FLAC Project encourages developers to not incorporate any kind of copy prevention schemes.

On PCLinuxOS, there are several programs that support the encoding of FLAC files. They include aTunes, Audacity, FFmpeg, and VLC. There are also several programs that support the decoding of FLAC
files, including aTunes, Audacity, FFmpeg, VLC, MPlayer, Songbird, Squeezebox, and XBMC Media Center. Several more programs support CD ripping, including aTunes, Songbird, Asunder, Banshee, Mencoder, Grip, K3b, and Konqueror (see the PCLinuxOS Magazine, July, 2009 issue) ... to name a few.

**SUMMARY**

Hopefully, this overview of audio file formats is helpful in sorting out performance issues with the various file formats, and helps you decide which format to use for your audio library. Of course, some of the decisions will already be dictated to you, based on the capabilities of the audio playback device you are using.

Most users are going to be perfectly satisfied with using one of the file formats that employ lossy formats (MP3 or Ogg Vorbis). But, to avoid the generational degradation, it's best to convert first to a lossless format (WAV, FLAC, AIFF), perform your edits, then transcode to one of the the lossy formats for the smaller file size.

Now ... where did I put that Garth Brooks CD?

**KDE Korner: Enable “Save per-folder view settings”**

The “Save per-folder view settings” option in Konqueror (in Preferences) allows you to remember the last view chosen for each folder.

For example, you can used the Detailed List view in your regular folders, and the Icon view in folders where you have images or multimedia content.

However, sometimes that option is disabled in Konqueror (it is there in the menu, but it is greyed out, so you can't actually select it). To fix this, open

```
~/.kde/share/config/konqueror.rc
```

and, in the section labeled `[MainView Settings]` add:

```
SaveViewPropertiesLocally=true
```
Almigi’s Welcome

Well, it looks like I'm gonna be staying awhile, so I figured I'd post the obligatory hello message to introduce myself. My real name is Alan, and I hail from Fairview Park, Ohio (which is just outside of Cleveland). My first attempt at Linux was years ago, and I focused mainly on commercial distros/distros that came with books about Linux. Back then, I thought that would be the easiest route to go (and with a dial up connection, it probably was). Of all the distros I tried back then, the one that really worked on the laptop I was using at the time was Mandrake (which of course, is now Mandriva). My venture into Linux didn’t last that long, and after a week or so, I went back to Windows (and it's not like I went back to a decent version of Windows like XP, I went back to Millennium Edition, glutton for punishment that I am).

However, a few months ago, I became interested in Linux again. I decided to try Ubuntu because it was the most popular. My rationale was that if it is the most popular, it would be the easiest distro to find help if I had any problems, as googling "Ubuntu <problem>" would probably yield the most hits. I downloaded and installed 8.10 and I was very impressed. Everything just worked.

Over the course of the past few months, I've tried a few distros out, and learned a fair amount about Linux. I also discovered that when it comes to applications and desktop environments, any distro can become any other distro with the right selection of packages (for the most part). What really sets distros apart (in my opinion) are:

1. Community. The community has to be friendly and genuinely enthusiastic about the distro, as well as active. If I'm curious about a new distro and I notice the forums are full of mostly spam or haven't had any activity in months, that's a red flag.

2. Repositories. A good distro has a good repository (or repositories). I don't mind manually installing the occasional .deb or .rpm, but with modern package management, it makes sense to use repositories whenever possible. If the repositories (official and community) have a decent selection of software (that's updated on a reasonable basis), that's a definite plus.

3. Good philosophy. I prefer distros designed with the end user in mind. Distros that focus on ease of use (even though I've become more competent with Linux over the past few months, I still prefer "automagic" detection and configuration of my hardware... more out of own laziness then anything else ) and stability. There was a time when "latest and greatest" was more of my style, but now I prefer "modern and stable." I prefer
new versions of software to take advantage of new features, but not at the expense of system breakage.

4. Active development. I want a distro that I know is going to be around for awhile.

I believe that PCLinuxOS right now meets all my criteria for a good distro. I've lurked in the forums for awhile and I think the community is great. From what I can see looking in Synaptic, (and reading in the forums) there seems to be a healthy selection of programs in the PCLOS repos. I also like the PCLOS focus on stability, and the "it will be ready when it's ready" method of development. It's better to wait for a working program then to get software delivered on a deadline that doesn't work. I also like that everything just worked out of the box. Granted, I prefer KDE4, but based on what I'm reading it shouldn't be too long until it's available for PCLOS. Besides, there's some cool themes at kde-look.org for KDE3.5, so I'll manage, and last, but not least, I'm pretty confident that PCLOS will be around for awhile.

I've also decided to try to put an end to my distro-hopping for awhile. No matter how tempted I am to try another distro out, I will only do so as a live CD. I will not install another distro on my HD for at least the next year. So, I will be a loyal PCLOS user until at least June 2010.

Thank you, Enki, for your generous support of PCLinuxOS and the PCLinuxOS Community
Startup Volume Script

by Hairyplotter

Sometimes while listening to music or watching a movie on my laptop, I will shut the computer down and forget to lower the volume.

So I wrote a small script and placed it in
~/.kde/Autostart to lower the volume to 30 if the current volume is higher than 30.

1) Open up kwrite and paste the following:

```bash
#!/bin/bash
if [ `aumix -q | grep vol | cut -d ' ' -f3` -gt 30 ]; then
  aumix -v 30
fi
```

2) Select File > Save As then type in:
~/.kde/Autostart/volume.sh

3) Click Save

4) Open Konsole then type: `chmod u+x
~/.kde/Autostart/volume.sh`

5) Press Enter and your all set.

Depending on how loud you want the volume to be by default, you can adjust it by changing the 30 in line 2 and 3 of the code above.

An alternate version of the script was also posted in the original forum thread by Woo58.

```bash
#!/bin/bash
if [ `aumix -q | grep vol | awk '{ print $3 }'` -gt 30 ]; then aumix -v 30
fi
```

Konqueror Korner: A Few Nifty Features

Konqueror is extremely customizable. Here are some features to remember.

- You can open a terminal in the folder you are in just by pressing F4.
- You can customize the number of toolbars you want, rearrange the icons and modify each icon’s image.
- You can use filters to view only specific kinds of files in a folder (images, pdfs, etc.)
- You can split the window (vertically or horizontally) as many times as you want.
- You can customize Konqueror and save each set of preferences to a specific profile.
by Archie Arevalo

Q: Can you give us a small introduction?

Ruel: My full real name is Ruel Lloyd Smith, Jr. and I live in Cincinnati, Ohio.

I'm a plumber by trade and goofball by hobby. I'm not really all that up on Linux in the area that I live in, but a huge Linux convention is held every year right up the road in Columbus, Ohio. I'd assume Linux is relatively in good position in this area. I do run into other Linux users at the local computer stores, so that's a good thing.

Q: How long have you been using a Linux operating system? If any, what Linux distributions have you tried? How can you best compare these other Linux to PCLinuxOS?

Ruel: I've been using Linux since I first installed Red Hat 5.2, circa 1998. I was very confused at the time, and really didn't catch on until I installed Mandrake 7.0. That was the turning point in my life. Suddenly, Linux was a very viable alternative. Other than these two distros, I've installed Fedora, Suse, Ubuntu/Kubuntu, Debian, Mepis, Sabayon, and my favorite, of course, PCLinuxOS. I've also installed PC-BSD and had unsuccessful attempts at installing FreeBSD and Gentoo. Also I've installed some of the community editions of PCLinuxOS and tried them out. I've been a PCLinuxOS user since 0.92 in 2006. I've been a Texstar fan before that, at a time when he had is own repository of files he compiled for Mandrake.

I found PCLinuxOS when one day I was trying to find out what happened to him in the interim between when I left Mandrake and came back to, now, Mandriva. I think the release was at .91 at the time, and I waited before trying it. A few fellow club members at Mandriva raved about this distro, and I finally had to install it. I've never looked back. It's like Texstar put all the elements of my dream distro together.

Each distro I've tried all had something in them that I liked better over another. Red Hat was a very solid distro in its day. I like the Control Center in Mandriva and Suse. Suse and Red Hat seemed to be more polish than the others. Debian and its derivatives use Synaptic/Apt. When I used PCLinuxOS for the first time, it was like Texstar had been where I had and...
combined all those great elements into one distro.

Choosing Linux is like choosing a car - there is no one-size-fits-all solution. PCLinuxOS just fits for me. But, the one thing that separated this distro from the rest is the community. With all the other communities, I always felt like just another number - a nobody. Here, I felt a sense of being part of the bigger picture. I've never felt the desire to become involved with anything about the distro in any other but PCLinuxOS. There is just this overall sense of wanting to give back. I see all these others doing what they can to contribute and I just had the desire to do the same.

I now use PCLinuxOS 99.9% of my computing time. That's about as Windows-free as I can be.

Q: You have been a long-time member of the PCLinuxOS community, and a forum member since April 18, 2006. What characteristics of users do you like in the forum?

Ruel: I like people that are willing to help out the next person. That's what community is about. In my opinion, that is what Linux and Open Source is about. We all contribute in our own little ways to make our distros, and Linux in the bigger sense, better.

Q: Have you ever had any experiences in the forum that you didn't like a particular user? If so, why?

Ruel: I can't point to a single user, but there have been new users that came in and had been argumentative or just can't seem to quite get the rules of the forum. These forum rules are posted clearly and there should be no debate about them. I don't care how another distro runs their forum, the rules are the rules and they've worked thus far to keep the forum a happy place for those who abide by them.

Q: As a prominent member of the PCLinuxOS Beautification Project, how do you find working with other members?

Ruel: Well, Geminiguy is one of those that I look up to. He and Didouph were there when I first poked my head into the Beautification Project with any intention to do something for it. He encouraged me more than anybody and I really like the work he does. I also have lots of respect for Weric and Tame. I can't say enough about how easy they were to work with. No one had any ego at all. It was just submitting work and speaking our minds freely, but I don't think anyone took any criticism harshly or anything. Personally, I'm just happy if anyone at all enjoys the fruits of my labor. When I started doing it, I never thought anything I did was good enough. I still don't sometimes.

Q: How do you come up with ideas in the form of your contribution to the Beautification?

Ruel: I get inspiration from everywhere. I look at what Sproggy, Linuzoid, Geminiguy, Weric, Tame, and others have done, as well as browse other sites like KDE-Look.org. I really look toward some of the work many Mac artists put out. That's an artistic bunch if I've ever seen one. The Mac platform tends to draw in those
types and the artwork they produce are top notch. I try not to copy anyone, but maybe borrow this element or that element and put a spin on it and do something with it. When we did the initial work for 2009, it was difficult to get inspired under pressure. We had to come up with stuff and we didn't exactly have an infinite amount of time to do it. Under those conditions, it’s difficult to just come up with something that "wows" people.

With the work on 2009, for instance, the logo was a product of Tame (who originally designed the official logo from Ludi’s contest winning entry), the logo colors were Geminiguy's idea from a wallpaper I had previously done, the ring was reshaded based on something Geminiguy did, and the globe was something Weric provided. I put all those elements together, added some additional graphical pop, and there you have it. I was inspired by the entries they were putting forth and "borrowed" those elements to put something together. We just bounced off each other pretty well.

**KDE Korner: A Few KDE Tips & Tricks**

**Adding or removing logout, lock, switch user, etc., options in Kmenu:**

Open `~/.kde/share/config/kickerrc` and paste the following (anywhere in the file):

```plaintext
[KDE Action Restrictions]
lock_session= true
logout_session= true
run_command=false {this removes the run

command box; just setting it to false won't work.
Remove to re-show the run command}
start_new_session=true
switch_user=true
```

With the exception of “run_command” (which is explained above) all you have to do is set to true if you want each option to be shown in Kmenu and to false if you don’t.

**Adding an extra panel icon to reload the repositories before opening Synaptic.**

Before PCLinuxOS incorporated update-notifier, I used to have to icons in my kicker panel to open Synaptic: the regular one and another that reloaded the repositories before opening Synaptic. All you have to do is place the mouse on the kicker panel, right click and select Add Application to Panel > Add Non-KDE Application. In the dialog that pops up, paste the following in the Executable box:

```
kdesu 'konsole --noframe --noscrolbar --nomenubar --notabbar -e apt-get update && synaptic'
```

Be sure that “Run in terminal” is **NOT** checked.

Name it whatever you’d like and assign it an icon (preferably one that's different from Synaptic’s, to avoid confusion).
ms_meme's little nook: PCLOS Arisin'

I see PCLOS a risin'
Straight to the top of the Distrowatch
It's not so very surprisin'
Our distro is topnotch

I hear the ranting and the ravin'
Oh sweet words of laud and praise
Everyone it is a cravin'
PCLOS has ‘em in a daze

If you choose another I don’t want to hear your cries
PCLOS is on the rise
You’ll lose with another I don’t want to hear your sighs
PCLOS is on the rise

I feel those downloads a comin’
Hope you’re prepared for a high
I hear PCLOS a hummin’
On it you really can rely
Disclaimer

1. All the contents of the NEW PCLinuxOS Magazine are only for general information and/or use. Such contents do not constitute advice and should not be relied upon in making (or refraining from making) any decision. Any specific advice or replies to queries in any part of the magazine is/are the person opinion of such experts/consultants/persons and are not subscribed to by the NEW PCLinuxOS Magazine.

2. The information in the NEW PCLinuxOS Magazine is provided on an "AS IS" basis, and all warranties, expressed or implied of any kind, regarding any matter pertaining to any information, advice or replies are disclaimed and excluded.

3. The NEW PCLinuxOS Magazine and its associates shall not be liable, at any time, for damages (including, but not limited to, without limitation, damages of any kind) arising in contract, rot or otherwise, from the use of or inability to use the magazine, or any of its contents, or from any action taken (or refrained from being taken) as a result of using the magazine or any such contents or for any failure of performance, error, omission, interruption, deletion, defect, delay in operation or transmission, computer virus, communications line failure, theft or destruction or unauthorized access to, alteration of, or use of information contained on the magazine.

4. No representations, warranties or guarantees whatsoever are made as to the accuracy, adequacy, reliability, completeness, suitability, or applicability of the information to a particular situation.

5. Certain links on the magazine lead to resources located on servers maintained by third parties over whom the NEW PCLinuxOS Magazine has no control or connection, business or otherwise. These sites are external to the NEW PCLinuxOS Magazine and by visiting these, you are doing so of your own accord and assume all responsibility and liability for such action.

Material Submitted by Users
A majority of sections in the magazine contain materials submitted by users. The NEW PCLinuxOS Magazine accepts no responsibility for the content, accuracy, conformity to applicable laws of such material.

Entire Agreement
These terms constitute the entire agreement between the parties with respect to the subject matter hereof and supersedes and replaces all prior or contemporaneous understandings or agreements, written or oral, regarding such subject matter.